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  Change History

Document 

 Version

 Release Date  Description
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



Added the description for importing and exporting cabinet 

files.

Added the description for restoring the device.

Added the description for automatically enabling the low 

latency function.

Added the description for adding sub-screens.

Added the description for screen correction.

Added the description for setting the preset switching effect.

Added the descripti







 on for image mosaic.

    

 

 

  

V1.2.0

 

 

2025-09-30



 

 





  



Added the description for the device standby mode.

Added the description for the options of the monitoring 

image definition, include smooth and high-definition.

Added the description for the dual receiving card backup.

Added the description for screen power-on and power-off 

through a remote control.

Added the description for the function of compatible with 

Mac.

 Added the description for the Unico client software.

    

  

  

  

V1.1.1 Added the description for the OSD function.

Added the description for the remote control.

Added the description for the HDR function.







2025-08-15

 Updated the Unico web page operations.

  

 

V1.1.0 Added the descriptions of the VX400 Pro, VX600 Pro and 2025-01-06

VX1000 Pro.

  V1.0.1  2024-12-16 Update Unico-related information.

  V1.0.0  2024-12-10 First release

Need LED display solutions? Contact Chipshow: 
manager@chipshow.com | www.chipshow.com



 
 VX Pro Series All-in-One Controller User Manual

 

 

   8
 

  

 

 

Applicable Products

The content described in the user manual is applicable for the following products:

VX400 Pro, VX600 Pro, VX1000 Pro and VX2000 Pro
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Applications

The application diagram takes the VX2000 Pro as an example.
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Home Screen

This chapter takes the VX2000 Pro as an example.

 

  

 

Home Screen

Figure 4-1 Home Screen

 No.  Content  Description

  1  VX2000 Pro The device name

 
 

 

 

 



 

Hold down the knob and BACK 

button simultaneously to lock or 

unlock the front panel buttons.

After the buttons are locked, all 

the button operations will not 

 

take effect and the icon will 

appear.

 

 After the buttons are unlocked, 

 the icon will disappear.

  192.168.0.10 The device IP address

   

  

  
 

Layer 1

Layer 2





2

 Layer 3

Displays the opened layer 

information, including the layer 

number, input source, input 

resolution and frame rate

  

 

3 Displays the resolution and frame 1920×1080@60

rate of the configured screen.

  The screen brightness
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 No.  Content  Description

   4 The Ethernet port is connected.

  The Ethernet port is not connected.

 
 

 

 

 

 The Ethernet port is connected 

and serves as the backup output 

port.

When the backup icon at the 

bottom flashes, there is data 



transmission on the port.

  

  

5 The sync function is enabled and the Synchronization

synchronization succeeded.

 

 The sync function is not enabled.

  

The sync function is enabled and the 

synchronization is in progress.

  

The sync function is enabled but the 

synchronization failed.

 

 

 Display control The output is black.

 

 The test pattern is shown.

 

 The output image is displayed.

 

 The output image is frozen.

 
 

 

Connection 

method

The device is connected to the 

control PC via an Ethernet port.

 
 

The device is not connected to the 

control PC.

 
 

The device is connected to the 

control PC via a USB cable.

 
  USB insertion 

status

USB drive inserted.

  No USB drive inserted.
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 Second Home Screen

 

 

 

 

 

 

OPT Status Screen

 

 

  

When the device is in Video Controller mode, this page may vary according to the device 

connected to the OPT port, as well as the OPT 3/4 working mode and the OPT loop mode.

 When a fiber converter is connected to OPT 1/OPT 2, the port is used as an output 

 

 

connector. The OPT status page displays the connection and backup statuses of the 

Ethernet ports on the fiber converter connected to the VX2000 Pro, as shown in Figure 4-2.

Figure 4-2 OPT Status screen

 

 

 

 When a PIXELHUE video processor is connected to OPT 1/OPT 2, the port is used an input 

 

connector. The OPT status page displays the resolution and frame rate of the accessed OPT 

source and the connection and backup statuses of the Ethernet ports on the fiber converter 

connected to the VX2000 Pro, as shown in Figure 4-3.

Figure 4-3 OPT input

 When OPT loop mode is enabled, the OPT status page is shown as follows.
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Figure 4-4 OPT Loop

 

 

 

You can set the working mode of OPT 3 and OPT 4 to Copy or Backup. The OPT status screen 

page will display the set working mode.
 

 

 

  

 

  

Fiber Converter Screen

  

When the device working mode is set to Fiber Converter, OPT 1~4 are all used for input and 

Ethernet ports are used for output. OPT 1 and OPT 2 serve as the primary connectors, while 

OPT 3 and OPT 4 serve as backup ones. The fiber converter screen page displays the data 

transmission status of Ethernet ports on the fiber converter.

Figure 4-5 Fiber converter screen

: There is data transmission on Ethernet port.

 : No data transmission on Ethernet ports
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  Menu Operations

 

 

  

 

 

 

 

 

Knob:

 

On the home screen, press the knob to enter the operation menu screen.

On the operation menu screen, rotate the knob to select a menu item and press the knob to 

confirm the selection or enter the submenu.

When a menu item with parameters is selected, you can rotate the knob to adjust the 

parameters. Please note that after the adjustment, you need to press the knob again to 







confirm the adjustment.

BACK: Exit the current menu or cancel an operation.
 

 

 

Screen Brightness

 

 

Screen brightness allows you to adjust the LED screen brightness in an eye-friendly way 

according to the current ambient illuminance. Besides, the brightness parameters can be saved 

to the receiving cards.

 

 

Prerequisites

The device is connected to a screen.

Screen Example
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Operating Procedure

Step 1 On the home screen, press the knob to enter the main menu screen.

Step 2 Select Screen Brightness and press the knob to confirm the selection.

 

Step 3 Rotate the knob to adjust the brightness value. You can see the adjustment result on the LED 

screen in real time. Press the knob to apply the brightness you set when you are satisfied with 

it.

 

 

  

 

Screen Configuration

Screen configuration allows you to perform the following operations, including configuring the 

screen, saving configuration to the receiving card, setting output mapping, setting the LED 

screen color and setting the output bit depth.

Figure 5-1 Screen configuration

 

 

Quick Configuration

 

  

  

 

When the LED screen is a regular one composed of cabinets from the same batch, you can use 

the quick configuration function to configure the LED screen.

Prerequisites

 

 The LED screen must be a regular one.

 The cabinets of the screen must be regular cabinets with the same resolution.

 The following data flow settings are supported. During data flow settings, ensure that each 

port's physical connection is along the same direction and downward to the next one.
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 During data flow settings, ensure that Ethernet Port 1 is at the beginning of the actual 

 

 

physical connection.

Figure 5-2 Data flow

Notes

 

 

 Cabinets loaded by Ethernet port 1 ≥ cabinets loaded by Ethernet port 2 ≥ ... ≥ cabinets 

  

loaded by Ethernet port n ("n" represents the maximum port number.)

 

  

 The number of cabinets loaded by each Ethernet port must be an integer multiple of 

 

 

 

  

Cabinet Row Qty or Cabinet Column Qty of the screen.

 

 The total pixels of the cabinets loaded by Ethernet port 1 cannot exceed 650,000.

Screen Example

 

   

Operating Procedure

Step 1 On the main menu screen, rotate the knob to go to Screen Configuration > Quick 

Configuration to enter the quick configuration screen.

 

  

Step 2 Set Cabinet Row Qty and Cabinet Column Qty according to the cabinets' actual row and 

column quantities.

 

  

Step 3 Rotate the knob to select Port 1 Cabinet Qty to set the quantity of the cabinets loaded by 

Ethernet port 1.

 

Step 4 Rotate the knob to select Data Flow (Front View) and press the knob to confirm. Select a 

physical connection for the cabinets.
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During data flow settings, you can see the result on the LED screen in real-time. If the entire 

screen displays content correctly, that is, no overlapping or repetition, press the knob to save 

the settings.

 

 

 

 

Save to RV Card

 

  

After the screen configuration information is sent to the receiving card, you can save the 

configuration to the card by using this function so that the configuration data will not be lost 

after a power failure.

Screen Example

 

Operating Procedure

On the main menu screen, go to Screen Configuration > Save to RV Card and press the knob 

to confirm.

 

 

Mapping

 

 

Mapping is used to show the relations between the cabinets of the LED screen and the sending 

devices so that you can view or check the connections between the cabinets.

 

Notes

The receiving cards that are connected to the device must support the Mapping function. For 

the supported models of the receiving cards, please visit our official website at 

www.novastar.tech.
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Screen Example

 

   

 

Operating Procedure

 

 

   

 

On the main menu screen, go to Screen Configuration > Mapping and turn on the function.

Figure 5-3 Mapping

 

Example: S:01 stands for the sending card number, P:01 stands for the Ethernet port number 

and #001 stands for the cabinet number.

 

 

LED Screen Color

 

This function allows you to adjust the color temperature and Gamma value of the LED screen to 

make the images displayed on the screen more clear and vivid.
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Screen Example

 

  

 

  

Operating Procedure

 

  

On the main menu screen, go to Screen Configuration > LED Screen Color to enter the screen 

color settings screen.

 Select Gamma and press the knob to confirm. Rotate the knob to adjust the Gamma value 

 

 

  

 

and press the knob to confirm when you are satisfied with it.

 Rotate the knob to select Color Temperature Mode and press the knob to confirm. Rotate 

 

the knob to adjust the temperature mode, including Standard, Cool, Warm and Custom, 

and then press the knob to confirm when you are satisfied with it.

When Custom is selected, you can customize the color temperature value.

 Perform the following operations as needed.

 

  

−

  

Save: Save the LED screen color parameters to the receiving card, so that the 

parameters will be not be lost after power failure.

− Reset: Reset all parameters to factory defaults.

 Parameter Descriptions

 Parameter  Description

 

 

  

Adjust the image distortion degree from the input to output. The greater the value is, 

the more distorted the image will be.

The

Gamma

value ranges from 0.25 to 4.00 and defaults to 2.8.

 

 

Color 

Temperature 

Mode

 

Adjust the cool or warm degree of images displayed on the LED screen. When 

Custom is selected, you can customize the color temperature value.
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 Set Output Bit Depth

 

 

Notes

 

 

When you use the HDR function, setting output bit depth to 10bit is required to achieve optimal 

display effect.

Screen Example

 Parameter Descriptions

 Parameter  Description

  

 

Bit Depth

 

Set the output bit depth.

The supported options include 8bit and 10bit.

 Send Cabinet Configuration Files

 

You can send the pre-stored configuration file to the receiving card to unify display effect on all 

cabinets with no need to perform operations on the control PC, realizing convenient debugging. 

The cabinet file can be exported and imported to other devices, facilitating multi-device control 

and on-site maintenance.

 

  

Prerequisites

 Before importing the cabinet file, you have placed the .rcfgx or .NCP file in the root directory 

 of the USB drive, and inserted the USB drive in to the USB 2.0 port on the device rear panel.
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  Before exporting the cabinet file, you have inserted the USB drive in to the USB 2.0 port on 

 the device rear panel.

 

  

 

Notes

 

 64 configuration files can be saved, with a total capacity less than 500 MB.

 It is recommended that the size and shape of the cabinets to be configured are the same, as 

 

 

well as use the receiving cards of the same model.

Screen Example

 Import Cabinet Configuration Files

 

  

 

You can import the cabinet file to the device cabinet library via the following methods.

 

    

 Method I: Import the file via Unico.

 Method II: Import the file via USB drive.

 

 

Step 1 On the Send Cabinet Config File screen, rotate the knob to select Import and press the knob 

  

to confirm.

Step 2 Rotate the knob to select the desired file and press the knob to confirm. In the popup dialog 

 

 

 

box, select Export or Export All.

Send Cabinet Configuration Files

 

You can send the cabinet file to the receiving card via the following methods.

 Method I: Send the file via USB drive.
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On the Import screen, rotate the knob to select the desired file and press the knob to 

confirm. In the popup dialog box, select Send to send the selected file to the receiving card. 

This file will not be imported to the cabinet library.

 

  

   

   

 Method II: Select the desired file in the cabinet library and send it.

Step 1 On the Send Cabinet Config File screen, rotate the knob to select Cabinet Library and press 

 

 

  

the knob to confirm.

Step 2 Rotate the file to select the file and press the knob to confirm.

Step 3 In the popup dialog box, select Send and press the knob to confirm.

Step 4 In the popup dialog box, select OK and wait for sending.

Export Cabinet Configuration Files

 

 

  

   

On the Send Cabinet Config File screen, rotate the knob to select Export. In the popup dialog 

box, select OK to export all cabinet files in the cabinet library to the inserted USB drive.

Delete Files in Cabinet Library

 

 

You can delete the file in the cabinet library via the following methods.

 Method I: Delete a single file.

Step 1 On the Send Cabinet Config File screen, rotate the knob to select Cabinet Library and press 

  

 

the knob to confirm.

Step 2 On the Cabinet Library, rotate the knob to select the desired file and press the knob to 

 

 

confirm. In the popup dialog box, select Delete to delete the selected file.

 Method II: Clear all files in the cabinet library.

 

On the Send Cabinet Config File, rotate the knob to select Clear Cabinet Library and press 

the knob to confirm. In the popup dialog box, select OK.
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 Layer Settings

 Add Layers

 Notes

 The maximum number of layers that can be added depends on the connected device.

 Device Model  Number of Supported Layers (2K×1K)

 VX400 Pro  6

 VX600 Pro

 VX1000 Pro

 VX2000 Pro  12

 

 

 

  

   

  

Screen Example

 

  

Operating Procedure

Step 1 On the home screen, press the knob to enter the main menu screen.

Step 2 Rotate the knob to select Layer Settings and press the knob to enter the layer settings screen.

Step 3 Rotate the knob to select Layer Settings and press the knob to enter the layer properties 

 

screen.

Step 4 Rotate the knob to select Layer No. and press the knob to display the layer list.
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In the layer list, both the current opened layers and the layers to be opened are displayed.

Layer name displayed in the layer list: Opened layer: Layer n (capacity), unopened layer: Layer 





n, and “n” represents the layer number.
 

  

   

   

 

 

 

Step 5 Rotate the knob to select the desired layer number and press the knob to confirm.

Step 6 Rotate the knob to select Layer Status and press the knob to turn on the switch.

Step 7 Rotate the knob to select Input Source and select the desired input source for the layer.

Step 8 Rotate the knob to select other layer parameters and set them if needed. The layer parameter 

 

 

  

descriptions are shown in Set Layer Properties.

Figure 5-5 Layer parameter descriptions

 Step 9 Rotate the knob to select Priority and set the layer priority.

 The greater the priority number is, the higher priority the layer has.

 

  

 

On the Layer Settings screen, rotate the knob to select Disable All and press the knob to disable 

all layers.
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 Set Layer Properties

 

 

Parameter Descriptions

 Table 5-1 Layer properties

 Menu  Description

 Layer No.  The layer number

 Layer Status  Open or close the layer

 

 By default, layer 1 is opened and uses the first input source.

 Input Source  Select an input source for the current layer.

 

 Press an input source button in the SOURCE area on the device front panel 

 to quickly select an input source for the layer.

 Scaling Mode  

  

The layer supports the following three scaling modes.

 

 





 

 

Full Screen: The layer image fills the whole screen.

Pixel to Pixel: The layer image is not scaled but displayed in the original 

size of the input source or the cropped source.

Custom: Customize the layer size and the output image is scaled 

according to the layer size.

  H Width

 

Set the layer size in the horizontal direction.

The width value ranges from 64 to 131070.

   V Height

 

Set the layer size in the vertical direction.

The height value ranges from 64 to 131070.

 

 

 

Set the horizontal distance between the top left corner of the layer and the 

top left corner of the screen.

The value ranges from -

Initial X

250000 to 248080.

 

 

 

Set the vertical distance between the top left corner of the layer and the top 

left corner of the screen.

The value ranges from -

Initial Y

250000 to 248080.

 Priority  

  

The layer priority

  

Up: Bring the selected layer forward.

 Down: Send the selected layer backward.
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 Menu  Description

   

  

Top: Bring the selected layer to the front.

 Bottom: Send the selected layer to the back.

 Input Crop  

  

  

  

 

 

Crop the input source image and display the cropped part on full screen.

 

 

Status: Turn on or turn off the function.

H Width: The size of the copped part in the horizontal direction

V Height: The size of the copped part in the vertical direction.

Initial X: Set the start position for the cropping in the horizontal direction. 

The value defaults to 0.

Initial Y: Set the start position for the cropping in the vertical direction. 

The value defau











lts to 0.

 3D  

  

Turn on or turn off the function.

  

On: 

 Off: 

 Input Crop

 

This function allows you to crop the input source image and make the cropped part display on 

full screen.

 Prerequisites

 A fine signal is connected to the input connector.

 

  

 

Notes

 

 The status and capacity of the cropped source remain consistent with the original one.

 The input cropping and 3D functions cannot be enabled at the same time.
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Screen Example

 

   

Operating Procedure

 

  

  

Step 1 On the Layer Settings screen, rotate the knob to select Input Source and press the knob to 

 

    

 

display the input source list.

Step 2 Rotate the knob to select the desired input source and press the knob to confirm.

Step 3 Rotate the knob to select Input Crop and press the knob to enter the input source cropping 

  

 

screen.

Step 4 Select Status and press the knob to turn on the function.

Step 5 Rotate the knob to configure the cropping parameters and set them if needed. The cropping 

 

 

parameter descriptions are shown in Set Layer Properties and Figure 5-5.

Figure 5-6 Input crop effect
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 OSD Settings

 

Both the text OSD and image OSD are supported. For the text OSD, four components are 

supported, including the static text OSD, dynamic text OSD, weather OSD and time OSD.

 

 

Prerequisites

 

 

 Before sending a text OSD to an LED screen via device, make sure that you have configured 

a text OSD preset in Unico.

 Before sending an image OSD to an LED screen via device, make sure that you have 

 

imported images in Unico, or imported images saved in a USB drive which is installed into 

the USB port on the device rear panel.

 

 

Notes

 The related parameters of a text OSD cannot be set via device LCD screen, and you need to 

 

 

set them in Unico in advance.

 Scaling and cropping an image OSD is not supported via device LCD screen, and you need to 

 

  

   

  

set the scaling ratio and cropped image after you have imported images in Unico.

 

 

 The OSD locates at the top and its priority cannot be adjusted.

 The text OSD and image OSD cannot be enabled together.

 The OSD function and remote control function cannot be enabled together.

Screen Example

 

 

Figure 5-7 Text OSDs
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Figure 5-8 Image OSDs

 

   

Operating Procedure

Step 1 On the Layer Settings screen, rotate the knob to select OSD Settings and press the knob to 

 

  

enter the OSD settings screen.

 

  

Step 2 Rotate the knot to select Status and press the knob to turn on the switch to enable the OSD 

 

  

  

 

function.

Step 3 Set the OSD type. The supported options include Text and Image.

 Text: You have configured a text OSD preset in Unico.

 Image: You have imported images in Unico or imported images saved in a USB drive.

Step 4 (Optional) Rotate the knob to set the initial X and initial Y of an image OSD, and press the knob 

 to confirm.

 

  

 

If the configured OSD parameters are changed, you need to click Apply in Unico to resend the 

OSD parameters.
 

 OSD Type Descriptions

 OSD Type  Description

   

 

  

  

  

 

Up to four text OSD presets are supported, and the preset 1 is selected by Text OSD 

default. The quantity of the text components are as follows.

 

− Static text OSD: 10

− Weather OSD: 2

− Time OSD: 2

− Dynamic text OSD: 1
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 OSD Type  Description

   Does not support settings of the size and position of a text OSD.

 

 The dynamic text OSD and other text components cannot be used together.

   

  

  

  

Image gallery capacity: 75 MB

Supported image OSD formats: PNG/JPG/JPEG/BMP





Image OSD

 Width and height limitations of a single image:

− VX400 Pro/VX600 Pro/VX1000 Pro: Max width × Max height ≤ 

 

 

4096×1080, max width: 10240 pixels, max height: 8192 pixels

 

 

  

  

− VX2000 Pro: Max width × Max height ≤ 4096×2160, max width: 16384 

  

pixels, max height: 8192

Note: If the max width and height limitations are exceeded, you need to 

scale or crop the image in Unico, and the width and height of the cropped 

should be greater than 64 pixels.

Supports setting of the image OSD position.

Does not support setting of the image OSD size.





 Does not support setting of the image OSD opacity.

 

 

  

 

OPT Source Descriptions

 

 

 

The device can receive long-distance video sources via OPT ports.

 The OPT source can be provide via a switcher or fiber extender.

 OPT 1 and OPT 2 match the silkscreens marked on the device rear panel. If two SL sources 

 

are received via OPT 1, both OPT 1-1 and OPT 1-2 have an input source respectively; if a DL 

source is received via OPT 1, only OPT 1-1 has an input source.

The relationship between the OPT source and OPT port is as follows.

Table 5-2 OPT source description

 Product Model  Description

  VX400 Pro

 

Self-adaptive OPT 1 for video input

You can select OPT 1-1 or OPT 1-2 source from 

the input source list displayed on the device LCD 

screen.

 VX600 Pro

 VX1000 Pro

  VX2000 Pro Self-adaptive OPT 1/OPT 2 for video input

You can select OPT 1-1, OPT 1-2, OPT 2-1 or OPT 

2-2 source from the input source list displayed on 

Need LED display solutions? Contact Chipshow: 
manager@chipshow.com | www.chipshow.com



 
 VX Pro Series All-in-One Controller User Manual

 

 

   31
 

 Product Model  Description

 the device LCD screen.

  

 

Figure 5-9 OPT input sources

 

 

 

 

Input Settings

 

 

The input settings allow you to switch the input connector capacity, set input resolution and 

InfoFrame override parameters, as well as configure mosaic sources.

Figure 5-10 Input settings
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 Switch Connector Capacity

 

Switch the input connector capacity to allow the device to calculate the number of layers that 

can be added based on the capacity.

 Prerequisites

 You have selected an input source.

 

 

Notes

 

 

Changing the connector capacity of the OPT source is not supported.

Screen Example

 

  

Operating Procedure

 

  

  

Step 1 On the input settings screen, rotate the knob to select Input Source and press the knob to 

 

 

display the input source list.

Step 2 Rotate the knob to select the desired input source and press the knob to confirm.

Step 3 Rotate the knob to select Capacity and press the knob to display the capacity list.

 Table 5-3 Connector capacity limitations

 Connector Capacity  Description

   

  

  

Standard resolution: 1920×1080@60Hz

Custom max width: 2048 (2048×1080@60Hz)





SL

 Custom max height: 2048 (1080×2048@60Hz)
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 Connector Capacity  Description

   

  

  

Standard resolution: 3840×1080@60Hz/3840×2160@30Hz

Custom max width: 4096 (4096×1080@60Hz)





DL

 Custom max height: 3840 (1080×3840@60Hz)

   

  

  

Standard resolution: 4096×2160@60Hz/8192×2160@30Hz

Custom max width: 8192 (8192×1080@60Hz)





4K

 Custom max height: 8188 (1080×8188@60Hz)

 

 

 

If the resolution of an input source is larger than the max width limit of the connector capacity, 

you need to switch the connector capacity to ensure that the input source can be processed 

normally.
 

  Step 4 Rotate the knob to select the target capacity and press the knob to confirm.

 

 

Set Input Resolution

 Set the input resolution and frame rate. The options include Standard and Custom.

 

  

  

Prerequisites

 

 

 The front-end device outputs the video source from the graphics card.

 You have selected an HDMI or DP source. SDI does not support this function.

Screen Example

 

 

Figure 5-11 Standard resolution
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Figure 5-12 Custom resolution

 

  

Operating Procedure (Standard Res)

Step 1 On the input settings screen, select the desired input source and press the knob to confirm.

Step 2 On the input resolution settings screen, select Standard.

Step 3 Rotate the knob to select Resolution, and press the knob to show the resolution list.

Step 4 Rotate the knob to select the desired resolution from the list and then press the knob to 

 

  

confirm.

Step 5 Rotate the knob to select the desired frame rate from the list and then press the knob to 

 

  

confirm.

Step 6 (Optional) Rotate the knob to select Display Resolution Details and press the knob to turn on 

 

 

  

 

the switch.

Step 7 Rotate the knob to select Apply and press the knob to complete the standard resolution 

 

  

settings.

Operating Procedure (Custom Res)

Step 1 On the input settings screen, select the desired input source and press the knob to confirm.

Step 2 On the input resolution settings screen, select Custom.

Step 3 Rotate the knob to select Width and press the knob to confirm. Rotate the knob again to select 

 

  

the desired width and press the knob to confirm.

 

  

Step 4 Rotate the knob to select Height and press the knob to confirm. Rotate the knob again to select 

the desired height and press the knob to confirm.

Step 5 Rotate the knob to select Frame Rate and press the knob to show the frame list. Rotate the 

 knob again to select the desired frame rate and press the knob to confirm.
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   Step 6 Rotate the knob to select Apply and press the knob to complete the custom resolution settings.

 Import and Export EDID

 

If you encounter a compatibility problem with an input connector, you can resolve it by 

importing a compatible EDID file into the device. You can also export an EDID file from the 

device and providing it to other devices or input connectors.

 

 

Prerequisites

 

   

 

 Before importing the EDID file, you have saved the file (.bin and .dat) to the root directory in 

 

an USB drive and inserted it into the device USB port.

 Before exporting the EDID file, you have inserted an USB drive into the device USB port.

 You have selected an accessed input source. SDI connector does support this function.

 

  

 

Notes

 

 Each input connector supports importing one EDID file only.

 Once the EDID file is imported, the input connector will recognize and apply the parameters 

 

 

from the file.

Screen Example

 

  

Operating Procedure (Import EDID)

Step 1 On the input resolution settings screen, rotate the knob to select Import EDID and press the 

 knob to enter the EDID file list screen.
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Step 2 Select the desired file and press the knob to confirm

Step 3 In the popup dialog, select OK to import the EDID file.

Operating Procedure (Export EDID)

 

  

  

Step 1 On the input resolution settings screen, rotate the knob to select Export EDID and press the 

 

knob to enter the EDID file exporting screen.

Step 2 Select the file format (.bin or .dat) and press the knob to confirm.

Step 3 Select Apply to apply the parameters saved in the file.

 

 

If you need to modify the content of an imported EDID file, just modify it and then re-import it to 

overwrite the original one.
 

 

 

Compatible with Mac

 

 

When the device is incompatible with the EDID of a Mac system, you may activate this feature 

to resolve the issue.

Screen Example

 Parameter Descriptions

 Parameter  Description

  Compatible with Mac  Turn on or turn off the function.

   : On
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 Parameter  Description

   : Off

 

 

Configure InfoFrame Override Parameters

 

 

Set the InfoFrame override parameters for the input source, allowing the device to use them 

during calculations. This won't alter the input source's original parameter values.

Parameter Description

 

 

You have selected an HDMI or DP source. SDI does not support this function.

Screen Example

 

  

Operating Procedure

 

  

 

Step 1 On the input settings page, rotate the knob to select InfoFrame Override and press the knob 

 

to enter the corresponding screen.

Step 2 Rotate the knob to set the color/sample of the input source and press the knob to confirm.

Step 3 Rotate the knob to set the quantization range of the input source and press the knob to 

 

confirm.

Parameter Descriptions

 Menu  Description

  

 

Color/Sample The sampling format of the input

The supported options include RGB 4:4:4, YCbCr 4:2:2, YCbCr 4:4:4 and 
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 Menu  Description

 From Input.

  

 

Quantization Range

 

The quantization range of the input

The supported options include From Input, Limited and Full.

  

 

Bit Depth

 

The bit depth of the input, i.e., the binary digits to represent a single color

The supported options include From Input, 8bit, 10bit and 12bit.

  

 

Gamut

 

The gamut standard of the input

The supported options include Rec.601, Rec.709, DCI-P3(D65), Rec.2020

and From Input.

 

   Select From Input and the device will read the attribute values that come with the input source.
 

 Configure Mosaic Sources

 Both HDMI and OPT sources support mosaicing.

 

  

  

Notes

 

 Only the VX2000 Pro supports this function.

 Only the input sources of the same connector type support mosaicing, and the frame rates 

 

 

of sub-source must be the same.

Screen Example
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Operating Procedure

 

   

  

   

Step 1 On the input settings screen, rotate the knob to select MOSAIC and press the knob to enter the 

 

 

mosaic source settings screen.

Step 2 Rotate the knob to select Source Type and press the knob to confirm.

Step 3 Select the desired mosaic layout.

Step 4 Set Width and Height for each mosaic area.

 If the input source width or height is less than the width or height value you set, the blank 

 

 

area will be filled with solid black.

 If the input source width or height is larger than the width or height value you set, the input 

 

  

 

source image will be cropped. The cropping takes the top left corner of the input source 

image as the reference point and then crops the image according to the set width and 

height values.

 

   

 The total width and height of the mosaic source will be displayed.

Step 5 Rotate the knob to select the mosaic layout area and press the knob to select sub-sources of 

each mosaic area.

Step 6 Rotate the knob to select Apply to make the settings take effect; otherwise, select Reset to 

 reset the settings to defaults.

 Parameter Descriptions

 Parameter  Description

  

 

Source type

 

The connector type of the sub sources

The supported options include HDMI 2.0, HDMI 1.3 or OPT.

 

 Each OPT port supports transmission of 2x SL or 1x DL source.

  Layout

 

 

The mosaic layout

The layout varies depending on the source type.

" and "  "

 

For HDMI 2.0, three layouts are supported: " 

For HDMI 1.3



 , eight layouts are supported: "

", "

", " ", " ", " ", " ", 

" ", " " and "  "

 For OPT , eight layouts are supported: " ", " ", " ", " ", " ", " ", 

" " and "  "
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 Parameter  Description

  Width

 

The width of the individual mosaic area

Default value: 1920 pixels

  Height

 

The height of the individual mosaic area

Default value: 1080 pixels

 Mosaic Size  

  

  

The size of the mosaic source

  

Max. width: 8192 pixels

Max. height: 8192 pixels





 Max. width and height: 4096×2160

 

 

The mosaic source capacity depends on the max capacity and number of sub-sources, that is, the 

capacity of a mosaic source composed of two DL sub-sources or SL+4K sub-sources is 4K.
 

 

  

Preset Settings

 

 

A preset is a set of parameters that save the layer and layer-related information. Up to 256 

user-defined presets are supported. After a preset is saved, you can load the preset simply by 

its name. The preset operations include Save, Load and Delete.

Screen Example

 

 

Figure 5-13 Preset settings

 Save Presets

 After the layer settings, you can save those settings as a preset.
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Screen Example

 

  

Operating Procedure

Step 1 On the preset settings screen, rotate the knob to select a preset.

Step 2 Press the knob to open the preset operations window.

 Step 3 Rotate the knob to select Save and press the knob to save the layer settings to this preset.

 After a preset is saved, the preset status on the right side changes to Saved.

 

 

Load Presets

 

 

This operation allows you to send a saved preset to an LED screen.

Screen Example

 

 

Operating Procedure

 Step 1 On the preset settings screen, rotate the knob to select a saved preset.
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Step 2 Press the knob to open the preset operations window.

Step 3 Rotate the knob to select Load and press the knob to load the preset.

 After a preset is loaded, the preset status on the right side changes to In Use.

 

 

 

Press the PRESET button on the front panel to quickly enter the preset setting screen. You can 

press a number button to quickly load the corresponding preset.
 

 

 

Delete Presets

 

 

 

  

  

    

  

This operation allows you to clear the data saved in the preset. The preset name will not be 

cleared.

Screen Example

 

Operating Procedure

Step 1 On the preset settings screen, rotate the knob to select a saved preset.

Step 2 Press the knob to open the preset operations window.

Step 3 Rotate the knob to select Delete and press the knob to open a confirmation window.

Step 4 Rotate the knob to select Yes and press the knob to delete the preset.
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Image Mosaic

 

 

When the LED screen cannot be loaded by a single device, you can mosaic multiple devices to 

expand the system overall loading capacity. This allows to drive a screen with larger physical 

areas and higher total pixels.

Connection Method

 

 

 

Figure 5-14 VX2000 Pro

 

 

Figure 5-15 VX1000 Pro

 Prerequisites

 None
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Notes

 

 

 It is advisable to use devices of the same type to load the screen. Otherwise, there will be 

 

 

seams between mosaic screens.

 To ensure image sync between mosaic screens, the system will use the layer 1 source as the 

sync source by default after you enable the image mosaic function. Please ensure that the 

signal source in use is stable and reliable.

 After enabling the image mosaic function, any changes made to layer 1 parameters will 

 cause this function to be automatically disabled.

 

 

Screen Example

 

   

Operating Procedure

 

  

Step 1 On the main menu screen, rotate the knob to select Image Mosaic and press the knob to enter 

  

 

the image mosaic settings screen.

Step 2 Rotate the knob to select Image Mosaic and press the knob to confirm. Rotate the knob again 

 

  

  

 

to select On and press the knob to confirm.

Step 3 Set the mosaic-related parameters for each device.

 Total H Pixels: The number of pixels in the horizontal direction of the LED screen

 Total V Pixels: The number of pixels in the vertical direction of the LED screen

 Load Area Width: The number of pixels in the horizontal direction of the area loaded by the 

 

 

current device

 Load Area Height: The number of pixels in the vertical direction of the area loaded by the 

 current device
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 Load Area Initial X: The initial horizontal coordinate of the top-left corner of the area loaded 

by the current device. The unit is pixel.

 Load Area Initial X: The initial vertical coordinate of the top-left corner of the area loaded by 

 the current device. The unit is pixel.

 Display Control

 

  

Notes

 

 

If the freeze or FTB function is turned on, the test pattern function is unavailable.

Screen Example

 Parameter Descriptions

 Menu  Sub-Menu  Description

 Normal  -  Display the content of the current input source.

 Freeze  -  Freeze the current frame of the output image.

 FTB  -  Make the output image fade to black.

 Test Pattern  Pure Color  The pure color test pattern

 Gradient  The gradient test pattern

 Grid  The grid test pattern

 Brightness  The brightness of the test pattern

  Spacing Level

 

Set the spacing between different color areas.

If a multi-color test pattern is selected, this parameter is 

available.
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 Menu  Sub-Menu  Description

  Spacing (px)

 

Set the spacing between the lines.

If a grid test pattern is selected, this parameter is available.

  Line Width

 

Set the width of the grid lines.

If a grid test pattern is selected, this parameter is available.

  Speed

 

Set the moving speed of the lines.

If a grid test pattern is selected, this parameter is available.

 

Preset Trans 

Effect

 

   

  

Set the preset switching effect. The supported options include 

Cut and Fade

-

.

  

 

 

Cut: Switch one preset to another with no transition effect.

Fade: Switch one preset to another with a fade effect.

After selecting Fade effect, you can set the transition duration. 





The value ranges from 1s to 3s and it defaults to 2s.

 

 

 



 

 

The fade effect takes effect on presets with less than 7x SL 

layers only.

Only the VX2000 Pro supports setting of the preset switching 

effect.

 

Output 

Color

  Brightness

 

The shading of lights in the image

Adjust the brightness value either as a whole or individually 

adjust the RGB components.

 

 

 

The ratio of the luminance of the brightest color to that of the 

darkest color

Adjust the contrast value either as a whole or individually adjust 

Contrast

the RGB components.

  Saturation

 

The color purity of the image

The higher the value, the more vivid the color.

 Hue  The relative degree of how bright or dark the image is

 

 

USB Playback

 

Play images or videos saved in a USB drive and configure the playback parameters. A USB 

source can be used as a layer source.

The models of devices that support USB playback and the corresponding output resolutions for 

USB sources are listed below.
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 Device Model  USB Source Resolution

 VX400 Pro  1920×1080@60Hz

 VX600 Pro

 VX1000 Pro

 VX2000 Pro  3840×2160@60Hz

 

 

  

Press the desired layer button in the LAYER area on the device front panel and then press the U-

DISK button to use a USB source to open a layer.
 

 USB Player

 Prerequisites

 A USB drive has been inserted and recognized in the U-DISK connector on the front panel.

 

 

Notes

 

 

Up to 128 files can be displayed in the playlist and the size of each file cannot exceed 128 GB.

Screen Example

 

   

Operating Procedure

 Step 1 On the main menu screen, go to USB Playback > USB Player to enter the USB player screen.
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Step 2 Rotate the knob to select the desired the file and press the knob to play the file or stop the 

 

playback.

The items displayed on this screen are as follows.

 Media files in compatible formats

 The playback mode

 The playback status

 

 

Playback Settings

 

 

Configure the playback-related parameters.

Screen Example

 

  

  

 

Limitations

 

 

  

  

  

  

 

 Single-partition USB drive supported

 File system: NTFS, FAT32 and exFAT

 Max. width and height of media files

 

Width: 3840 pixels, height: 2160 pixels

 Picture format: jpg, jpeg, png and bmp

 Decoded image resolution: 3840×2160 or lower

 Video format: mp4, mkv, mov, avi, flv, m4v, mpg, mpeg, ts

 Video coding: H.264, H.265, MPEG-2, MPEG-4

 Max. video frame rate:

 H.264: 3840×2160@30fps, H.265: 3840×2160@60fps
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MPEG-2/MPEG-4: 1920×1080@60fps

 Max bitrate:

 

 

H.264/H.265: 100Mbps

MPEG-2/MPEG-4: 50Mbps

 Audio coding: AAC, AC3, DTS, MP3, DVD, DVD_LPCM, MP2, OPUS

 Audio sampling rate:

 

opus: 24kHz, 48kHz

Other formats: 22.05kHz to 94kHz

 Parameter Descriptions

 Parameter  Description

 Playback Mode  The playback mode of the file

 

 



 

 



  

Loop: Play the files in the playlist in order. Once the playback of the last file 

is completed, replay the first file.

Play in Order: Play the files in the playlist in order. Once the playback of the 

last file is completed, the screen will display a black image and the playback 

will stop.

 Repeat One: Loop playback of the current file.

 File Type  

  

  

The type of the playback file

  

Video

Image





 All: Videos and images

 

After the file type is selected, only the file of the selected type will be displayed 

 in the playlist.

 

 Image Playback 

Duration (s)  

The duration of the image playback

The value ranges from 1 to 60 and it defaults to 5. (Unit: s)

  Image Trans Effect

 

The trans effect of the image

Supported trans effect: Ripple, zoom in, cut out, flip, blinds, H wipe, V wipe, 

cube, dissolve, grid, swapping, scroll, fade in/out, twirl, heart trans, doorway, 

perspective triangle, disappear, bounce, pinwheel and random

 

 Image Trans Duration 

(s)  

The trans duration of the image

The value ranges from 0.5 to 2 and it defaults to 0.5. (Unit: s)
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 Parameter  Description

 

 

Set whether to automatically play the USB files after the device is powered off Auto Playback

and then power on with a USB drive inserted.

  

 

 

: On

If Resume Playback not enabled, replay the files in the playlist in order; If 

enabled, replay the file being played before power failure from the 



beginning.

   : Off

  

 

Resume Playback 

  

On: If a file is playing before the device power failure, enabling this function 

allows to replay the file from beginning after the device is powered on with 

a USB drive inserted.

 Off: Replay the files in the playlist in order.

 

   

 



  

 

Enabling Resume Playback will also activate the Auto Playback feature at 

the same time.

After Resume Playback is enabled, if the file being played before power 

failure cannot be found, the files will be played from the beginning of the 



playlist in order.

  Volume

 

Playback volume of a media file

The value ranges from 0 to 100 and it defaults to 50%.

 Advanced Settings

 End-to-End Backup

 

The end-to-end backup is supported, including device backup, input source backup and 

Ethernet port backup test, stable and reliable.

 

 

Device Backup

 

The backup between devices and Ethernet ports are both supported.

5.11.1.1.1   Backup Between Devices

Device backup allows you to set the backup relationship between two devices. You can set one 

of the devices as the primary device or the backup device. When the primary device has a 
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problem or the primary device's Ethernet cable fails, the backup device will take over the 

responsibilities of the primary device seamlessly and continue to work well to ensure the LED 

screen will not go black.

 

 

Prerequisites

 

 

 Before creating a backup relation, make sure that both the primary and backup devices are 

on the same LAN.

 In a backup relation, the models and device versions of the primary and backup devices must 

 be the same.

 

 

Notes

 You have three options to create a backup relation: NovaLCT, Unico, or the device LCD 

 

 

menu. However, be aware that these methods do not synchronize with each other. Using 

more than one can lead to data problems. To prevent issues, choose only one method for 

setting up your backup. If you do mix them, you'll need to reset the device to factory settings 

and start over with just one method.

 

 In the device backup mode, the quantity of the cabinets loaded by each Ethernet port on 

 

both the primary and backup devices must be the same, but their data flow must be in a 

reversed way.

Hardware Connections

 The diagram takes the VX2000 Pro as an example.
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Screen Example

 

    

Operating Procedure

 

 

  

   

Step 1 On the main menu screen, go to Advanced Settings > End-to-End Backup > Device Backup to 

enter the device backup screen.

The available devices on the same LAN will be automatically searched.

Step 2 Set the primary device.

Step 3 Rotate the knob to select Backup IP and press the knob to display the backup IP list. Select the 

 desired IP address of a device to be set as a backup one.

 

 

 

After a backup relation is created, the configuration parameters (except communication 

settings) of the p



rimary device will be automatically synchronized to the backup device.
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After a backup relation is created, you can adjust the screen parameters on the front panel of 

the backup device without unbinding the backup relationship when the primary device is 

pow



ered off.
 

 

 

5.11.1.1.2   Backup Between Ethernet Ports

 

Ethernet port backup allows you to set the backup relationship between two Ethernet ports. 

When the primary port has a problem or the primary port's Ethernet cable fails, the backup port 

will take over the responsibilities of the primary port seamlessly and continue to work well to 

ensure the LED screen will not go black. When setting the backup between the Ethernet ports, 

you need to complete it in NovaLCT.

Hardware Connections

 

 

This diagram takes the VX2000 Pro as an example.

 

  

Operating Procedure

 

   

  

Step 1 Run the NovaLCT software. On the menu bar, go to User > Advanced Synchronous System 

 

User Login. Enter the password and click Login.

Step 2 Click Screen Configuration to enter the screen configuration page.

Step 3 Click Next to enter the screen configuration page.
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Figure 5-16 Screen configuration

 

  

 

  

Step 4 Select the Sending Card tab, and then click Add in the Redundancy area.

Step 5 Set the serial numbers of both the primary device and backup device to 1.

Step 6 Set the serial number of the primary port and the serial number of the corresponding backup 

port.

Figure 5-17 Ethernet port backup

Step 7 Click Add to complete the backup settings of an Ethernet port, and the system will 

 automatically list the primary ports and backup ports.
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Figure 5-18 Primary Ethernet ports

 Step 8 Repeat Step 6 and Step 7 to complete the backup settings for other Ethernet ports.

 Input Backup

 

Input backup allows you to set the backup relationship between two input sources. When one 

input source has a problem or the input connector fails, the backup source will be used 

seamlessly and continue to work well to ensure the LED screen will not go black.

 

 

  

  

  

  

 

Notes

 

Input backup rules:

 In each backup group, two input sources serve as the backup for each other.

 The backup relation can only be established if the input connectors have identical capacities.

 The USB source supports the input backup settings.

 Each primary or backup source can have only one backup or primary source.

 Restrictions on input backup functions:

 

Input sources A and B form a hot backup group. The current input source of the layer is 

input source A.

  − Input A: No signal. Input B: Signal

Need LED display solutions? Contact Chipshow: 
manager@chipshow.com | www.chipshow.com



 
 VX Pro Series All-in-One Controller User Manual

 

 

   56
 

 

 

  

 

−

  

 

−

  

 

The layer input source is switched to input B automatically. When input A resumes and 

input B still has a signal and Primary Source Preferred is not enabled, the layer input 

source will not be changed.

Input A: No signal. Input B: Signal

The layer input source is switched to input B automatically. When input A resumes, but 

input B does not have a signal, the layer input source will be changed to input A.

Input A: No signal. Input B: No signal

The layer input source will not be changed.

Input A: Signal. Input B: No signal

If you manually switch the layer input source to input B, the source will automatically 

−

switch to input A.

 

 

Screen Example

 

    

Operating Procedure

 

   

  

  

 

Step 1 On the main menu screen, go to Advanced Settings > End-to-End Backup > Input Backup to 

 

 

enter the input backup settings screen.

Step 2 Rotate the knob to select Input Backup and press the knob to turn on the function.

Step 3 Rotate the knob to select the desired primary input source on the left side.

Step 4 Rotate the knob to select the desired backup input source on the right side.

Step 5 (Optional) Set the primary source preferred.

 On: The primary source will always be used if there is a signal. When the primary source fails, 

 

the layer input source is switched to the backup one automatically. Once the primary source 

resumes, the layer input source seamlessly switches back to the primary source.
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 Off: The layer input source will be switched to the primary source only when the backup one 

 fails and the primary one has a signal.

 Ethernet Port Backup Test

 

Test whether the pre-stored images, backup Ethernet ports and devices take effect without 

plugging and unplugging the Ethernet cables.

 

 

Prerequisites

 

 

The pre-stored images, primary and backup Ethernet ports or primary and backup devices have 

been configured.

Screen Example

 Parameter Descriptions

 Parameter  Description

 

 

Enable the output of all the Ethernet ports on the current device to Off

complete the test.

 

 

Disable the output of the primary Ethernet port on the current device to test Backup Only

whether the backup port or device takes effect.

 

 

Disable the output of the backup Ethernet port on the current device to test Primary Only

whether the output of the primary port is normal.

 

 

Disable the output of all the Ethernet ports on the current device to test 

whether the pre-

Disconnect All:

stored image takes effect.
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Dual RV Cards Backup

 

Receiving card backup allows you to set the backup relationship between two receiving cards. If 

the primary receiving card link fails, the backup one will take over the responsibilities of the 

primary receiving card and continue to work well to ensure the LED screen will not go black.

 Prerequisites

 Two receiving cards are connected to the cabinet.

 

 

Notes

 

 

When you enable both the device backup and dual receiving cards backup, the former takes 

precedence over the latter. When the layer sources of two devices are disconnected, the device 

will switch to the backup receiving card link.

Screen Example

 Parameter Descriptions

 Parameter  Description

 Dual RV Cards Backup  

  

Turn on or turn off the function.

  

: On

 : Off
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 Synchronization

 

This function allows you to select a synchronization signal to synchronize all the cascaded 

device units or synchronize the primary and backup devices to display the output images of all 

the units in sync.

 

 

Notes

 The input source with or without signal can be used as a sync source. When a no signal 

 

  

 

source is used, the sync fails.

 

 Synchronizing to a DP source is supported by the VX2000 Pro only.

 Before enabling the Genlock sync function, make sure the sync signal has been connected to 

 

 

 

   

the Genlock connector of the device.

Screen Example

  

  

Operating Procedure

Step 1 On the main menu screen, go to Advanced Settings > Synchronization to enter the 

synchronization settings screen.

Step 2 Rotate the knob to select Sync To and press the knob to display the sync source list. The 

 

  

 

options include Internal, an input source connected to the device's video connector and 

Genlock. ("X" represents the input source number and its format may vary depending on the 

actual setup.)

 Internal: The frame rate of the output image

 An input source connected to the device's video connector: Sync with the frame rate of the 

 selected input source. After a sync source is selected, the sync frame rate will be displayed.
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 Genlock: Sync with the frame rate of the Genlock signal.

Step 3 (Optical) If Internal is selected, you can manually set the output frame that defaults to 60Hz.

 Once the synchronization is successful, the screen will show Successful

 Audio Settings

 This function allows you to set the audio status, output audio, volume and input audio.

 

 

 

Hardware Connections

 

The diagram takes the VX2000 Pro as an example.

 Via a multifunction card

 

 

 

Connect the Ethernet port 1 or 2 to a multifunction card, and then connect the multifunction 

card to an external speaker.

  Via the audio output connector

 Connect the audio output connector to an external speaker.
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Screen Example

 

 

Set Audio Status

 

 

Turn on or turn off the audio.

Screen Example
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Operating Procedure

Step 1 On the main menu screen, go to Advanced Settings > Audio to enter the audio settings screen.

Step 2 Rotate the knob to select Status and press the knob to confirm.

Step 3 Rotate the knob to select On or Mute to turn on or turn off the audio.

 

 

Select Output Audio

 

 

Set to output the layer audio, analog audio or embedded audio of an input source.

Screen Example

 

    

Operating Procedure

 

 

Step 1 On the main menu screen, go to Advanced Settings > Audio > Output and press the knob to 

 

 

display the output audio list.

Step 2 Select the desired output audio and press the knob to confirm.

 

 

 Layer n: Output the audio of the current layer input source. When you switch the current 

 

 

layer input source, the audio will also be changed.

 Audio In: Output the analog audio coming from an external audio device. When you switch 

 

the current layer input source, the audio will not be changed.

 Embedded audio of an input source: Output the fixed embedded audio. When you switch 

 

the current layer input source, the audio will not be changed.

The supported input source types include HDMI sources, DP sources, and USB sources.
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 The input source audio of the layer 1 is output by default.
 

 

 

Set Output Volume

 

 

 

    

  

Adjust the output volume.

Screen Example

 

Operating Procedure

Step 1 On the main menu screen, go to Advanced Settings > Audio to enter the audio settings screen.

Step 2 Rotate the knob to select Volume and press the knob to confirm. Then rotate the knob again to 

 

adjust the audio volume and press the knob to confirm.

Parameter Descriptions

 Parameter  Description

  Volume

 

The output volume

The value ranges from 0 (silent) to 100 (loudest) and defaults to 50.

 Set Input Source Audio

 

Bind audio sources of different types to video sources. When you switch the layer source, the 

audio source will be synchronously changed.
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Screen Example

 

    

Operating Procedure

 

 

Step 1 On the main menu screen, go to Advanced Settings > Audio > Input Audio and press the knob 

 

to enter the corresponding screen.

Step 2 Select the desired input source and set the corresponding parameter.

 Source Type  Description

 DP/HDMI/USB source  Supported options: Embedded, Audio In

 SDI source  Supported options: None, Audio In

 

 

Low Latency

 

When the input source travels from where it comes to the processing device, sending device 

and then the receiving card, latency exists inevitably. Turning on this function can effectively 

help to reduce the latency from the input to output.

 

 

 

Notes

If you set the low latency mode to Auto, the system will determine whether to enable the low 

latency based on the screen topology. The specific rules are as follows.

 For a single Ethernet port with vertical cabling and no overlap in the Y direction, the low 

 

latency will be automatically enabled if all the following requirements are met; otherwise, it 

will be disabled.

 

 

The cabinets loaded by one Ethernet port cannot be overlapped, while blank −

configurations are allowed.
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−

  

 

 

The circumscribed rectangles of all cabinets loaded by Ethernet ports must be aligned 

at the top of the canvas.

− No need to keep the same cabinet size.

 For free topology, the low latency will be automatically enabled if all the following 

 requirements are met; otherwise, it will be disabled.

 

 

−

 

 

−

  

The cabinets loaded by one Ethernet port cannot be overlapped, while blank 

configurations are not allowed.

The circumscribed rectangles of all cabinets loaded by Ethernet ports must be aligned 

at the top of the canvas. The size of the circumscribed rectangle cannot exceed 650,000 

pixels.

− The size of all cabinets must be the same.

 

  

   

  

 

Operating Procedure

 

On the main menu screen, go to Advanced Settings > Low Latency and press the knob to 

confirm. Then, rotate the knob to select On, Off or Auto as needed.

 Off: Turn off the function. (Default option)

 On: Turn on the function. The device latency can be reduced by 1 frame.

 

 

After you manually enable the low latency function, it is advisable to align the circumscribed 

rectangle loaded by each Ethernet port at the top of the canvas. If not aligned, the loading 

capacity will be reduced. For calculating the actual loading capacity, please refer to Loading 

Capacity Calculation Method in Low Latency Mode.
 

  Auto: If you set the low latency mode to Auto, the system will determine whether to enable 

 

the low latency based on the screen topology. If the wiring meets the rules, low latency will 

be enabled automatically; otherwise, it will be disabled automatically. For specific rules, 

please refer to the notes in this section.

Need LED display solutions? Contact Chipshow: 
manager@chipshow.com | www.chipshow.com



 
 VX Pro Series All-in-One Controller User Manual

 

 

   66
 

 HDR

 

HDR is the abbreviation for High-Dynamic Range. HDR function can greatly enhance the display 

image quality, allowing for a more clear and vivid image when the device is used together with 

the specified receiving cards.

 

 Only the VX2000 Pro supports the HDR function.
 

 HDR Source Settings

 Set the related parameters of an HDR source.

 

  

 

Prerequisites

 

 Use the layer 1 source as an HDR source.

 An HDR source (HDR10/HLG standard) must be used to realize optimal HDR effect.

 

  

  

 

Notes

 

 An HDR source can be connected to the HDMI 2.0 or 12G-SDI connector only.

 The HDR and 3D functions cannot be used together.

 Using the HDR function paired with receiving cards of different models will reduce the 

 

 

device loading capacity by half or quarter because the HDR input source is 10-bit. Please 

work out a connection solution in advance.

Screen Example
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Operating Procedure

 

   

  

 

Step 1 On the main menu screen, go to Advanced Settings > HDR Settings > HDR Source Settings to 

 

 

enter the HDR source settings screen.

Step 2 Rotate the knob to select HDR Source and press the knob to expand the HDR source list.

Step 3 Rotate the knob to select the target HDR source and press the knob to confirm.

Step 4 Set the dynamic range of the HDR source.

 

 

Figure 5-19 HDR effect

 Parameter Descriptions

 Menu  Description

 

 

You can select an HDR source connector through the HDMI 2.0 or 12G-SDI HDR Source

connector.

  

 

Dynamic range

 

The dynamic range of an HDR source

The supported options include HDR10, HLG, off and From Input.

 

 

 

When you enable the HDR function, the receiving card supporting this function should be used 

together. For the specified receiving card model and related information, please refer to our 

official website (www.novastar.tech).
 

 Adjust EOTF

EOTF is the abbreviation for Electro-Optical Transfer Function. It allows for precise tuning of 

the electro-optical conversion characteristics of a signal source, significantly improving the 

overall brightness performance, details of the darkest areas, clarity of the highlight areas and 
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final contrast effect. Additionally, adjusting images based on different ambient light conditions 

is also supported to achieve a more desirable viewing experience.

 

 

Notes

 

 

The supported adjustment parameters depend on the HDR source settings.

Screen Example

 Parameter Descriptions

 Parameter  Description

 

 

 

Adjust this parameter to enhance the image display effect. The greater the 

value, the clearer the details in the shadow area.

Shadow Compensation

Range: 0 to 100 (default: 33), Step: 1

  

Ambient Light 

Compensation

 

Adjust this parameter to reduce the loss of image details caused by ambient 

light diffusion.

Range: 0 (default) to 80 , Step: 1

 

 

 

Adjust the parameter to reduce the screen overexposure and enhance 

details of the highlight areas.

Range: 0 (default

Clip Level

) to 100 , Step: 1

 

Override Peak Screen 

Brightness

 

  

Turn on or turn off the function.

  

On: 

 Off: 

  

 

Peak Screen Brightness

 

Adjust the brightness of the screen when it is functioning normally.

When Override Peak Screen Brightness is enabled, this parameter can be 

adjusted. Range: 100 to 10000 nits (default: 1000 nits), Step: 1
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3D Settings

 

Directly connect a third-party 3D emitter using the device's built-in 3D connector, or connect to 

the EMT200 Pro emitter via the device's Ethernet port. Then, use the compatible 3D glasses to 

achieve a 3D display effect.

 

  

  

Prerequisites

 Video source format: Side-by side, top-and-bottom or frame sequential

 When paired with the EMT200 Pro, it is recommended to use a 3D source of 60Hz to enjoy 

 an optimal experience.

 

  

Notes

 When the 3D function is enabled and the video source format is Side-by-Side or Top-and-

 

 

Bottom, the device output capacity will be halved.

 When the 3D function is enabled and the video source format is Frame Sequential, you need 

 

 

to manually set the output frame rate which must be the same as the input frame rate.

 The 3D effect follows the layer. The output area where a 3D layer is located always displays 

 

  

the 3D effect.

 

 The 3D function and input cropping cannot be enabled at the same time.

Hardware Connections

 

 

The diagram takes the VX2000 Pro as an example.
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Screen Example

Operating Procedure

Step 1 On the main menu screen, go to Advanced Settings > 3D Settings > Status to turn on the 

 

 

function.

 

 

   

   

 

Step 2 Select the 3D format of the video source. The options include Side-by-Side, Top-and-Bottom

 

and Frame Sequential.

Step 3 Set the eye priority. The options include Left and Right.

Step 4 (Optional) Turn on the Enable Third-Party Emitter switch.

Step 5 Set the signal delay duration.

 The value ranges from 0 to 20000 and defaults to 7000. (Step: 1, unit: us)

 

 

Standby Mode

 

Enabling standby mode can effectively reduce energy consumption caused by screen heat 

generation.

Parameter Descriptions

 Parameter  Description

 Standby Mode  Turn on or turn off this function.

  

 

: On

Once the standby mode is enabled, the output image will go black and 

the output volume will be adjusted to 0. The device LCD screen will also 



be locked, while other parameters remain unchanged.
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 Parameter  Description

   : Off

 

 

HDCP Status

 

High-bandwidth Digital Content Protection (HDCP) is a form of digital copy protection to 

prevent copying of digital audio and video content as it travels across connections. When the 

accessed input source is an HDCP-encrypted one, you need to turn on this function to enable 

the device to transmit and process the source.

Parameter Descriptions

 Parameter  Description

 HDCP Status  Turn on or off HDCP function for the input source.

 

 

Monitor Settings

 

Real-time display of the output image via the monitor connected is supported. You can monitor 

whether the output is normal and adjust the display ratio of the monitoring image on the 

monitor to avoid image distortion.

Parameter Descriptions

 Parameter  Description

   Scaling Mode  

  

The options include Keep Ratio and Full Screen (default).

  

Keep Ratio: Keep the ratio of the original output image to display.

 Full Screen: Display the output image in full screen.

 

 When Keep Ratio is selected, the blank area that the output image cannot 

 cover the entire monitor screen will be automatically filled with solid black.

  Definition  

  

The supported options include Smooth and High-Definition.

  

Smooth: The monitoring image definition is 1920×1080@60Hz.

High-



 Definition: The monitoring image definition is 3840×2160@60Hz.
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 System Settings

 

 

Fn

 

 

This function allows you to set a shortcut button for an assigned function. By using the Fn 

button, you can quickly navigate to the target menu screen and never need to access a 

specified menu item by entering the menus level by level.

Screen Example

 

   

Operating Procedure

 

 

Step 1 On the main menu screen, go to System Settings > Fn press the knob to enter the Fn button 

 

settings screen.

Step 2 Rotate the knob to select the desired function and press the knob to confirm.

 

 

   

Return to Home

Operating Procedure

 

 

Step 1 On the main menu screen, go to System Settings > Return to Home and press the knob to 

 

confirm.

Step 2 Rotate the knob to select the desired time value and press the knob to confirm.
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 Parameter Descriptions

 Parameter  Description

 

 

 

You can set the period when the system stays at the current screen before 

returning to the homepage automatically when there is no operation 

performed.

Return to Home

The value ranges from 60s to 3600s

 Diagnostics

 

The diagnostics function helps you to diagnose the system and troubleshoot the malfunctioned 

device components. When the device fails, you can run the diagnostics function to test the 

device. You can send your test to our technical support staff for problem locating and 

processing. For daily maintenance, you can run the diagnostics function to do the routine health 

check for the system.

 

 

Notes

 

   

Running diagnostics will transiently disrupt the output, and the output will resume after the 

diagnostics are completed.

Operating Procedure

 

   

  

Step 1 On the main menu screen, go to System Settings > Diagnostics and press the knob to enter 

 

the diagnostics screen.

Step 2 Rotate the knob to select Run Diagnostics and press the knob to confirm,

Step 3 In the popup dialog, rotate the knob and select Yes and press the knob to confirm.

 Export Logs

 Export the device logs to a USB drive to quickly identify issues.

 Prerequisites

 Before exporting logs, you have inserted a USB drive into the USB port on the device.
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Operating Procedure

Step 1 On the main menu screen, go to System Settings > Log Export to enter the log exporting 

 

  

screen.

Step 2 Rotate the knob to select Apply and press the knob to confirm. The log file will be exported to 

 the root directory of the USB drive.

 

 

Update Device

 Import the update file saved in a USB drive to the device for quick update.

 

 

Prerequisites

 

 

 Before updating the device, you need to decompress the firmware package and copy the 

update file (.img) to the root directory of a USB drive. The supported USB drive formats 

include NTFS, FAT32, and exFAT. It is recommended to use a USB drive in FAT32 format.

 Before updating the device, you need to insert a USB drive with the update file into the USB 

 2.0 port on the device rear panel.

 

  

 

Notes

  

 During the update process, power-off and all operations are NOT allowed.

 Additionally, you can update the device via Unico or NovaLCT. For detailed operations, 

 

 

please refer to Maintain Devices or NovaLCT user manual respectively.

Screen Example
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Operating Procedure

Step 1 On the main menu screen, go to System Settings > Update to enter the device update screen.

Step 2 Rotate the knob to select the update file and press the knob to confirm.

Step 3 In the popup dialog box, rotate the knob to select OK and press the knob to confirm. Then wait 

 for the device to automatically complete the update.

 Restore Devices

 

Each restore point is a snapshot of the device configuration at a specific moment. If something 

unexpected occurs, simply select a restore point to quickly revert the device configuration to 

the state it was in at the time the restore point was created.

 

 

Prerequisites

 

 

None

Notes

 

 

Up to 5 restore points can be created (total capacity limit: 1GB).

Screen Example

 

   

Operating Procedure

Step 1 On the main menu screen, go to System Settings > Restore Device to enter the device 

 restoration screen.
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Step 2 Perform the following operations as needed.

 

 Add the restore point: Rotate the knob to select New Restore Point and press the knob to 

 

 

confirm.

The prefix for the name of the new restore point is the date when the operation is 

performed.

  

 

 Restore the device: Rotate the knob to select the target restore point and press the knob to 

 

confirm. In the popup dialog box, select Restore and press the knob to confirm.

 Delete the restore point: Rotate the knob to select the target restore point and press the 

 knob to confirm. In the popup dialog box, select Delete and press the knob to confirm.

 Cascading ID

 

Set the device cascading ID which is the unique identification when the device is in a cascading 

link.

 

  

Notes

 The cascading ID defaults to 1 and can be changed manually. You need to set an ID for each 

 

  

cascading device in order.

 

 After you set IDs successfully, connect devices using Ethernet cables based on the set ID.

Parameters Description

 Parameter  Description

 

 

When multiple devices are cascaded, you need to set a virtual ID for each 

device, ensuring that the devices displayed in NovaLCT match with actual 

Cascading ID

devices.

 Remote Control

 Enable or disable the remote control.

 

 

Prerequisites

  Insert the matching Bluetooth module into the USB 2.0 port on the device rear panel.

Need LED display solutions? Contact Chipshow: 
manager@chipshow.com | www.chipshow.com



 
 VX Pro Series All-in-One Controller User Manual

 

 

   77
 

 

 

 

 The remote control and the device have been successfully paired. For the pairing method, 

 

please refer to Button Descriptions

 The resolution of the loaded LED screen must be greater than 800×600.

 

  

  

Notes

 

 

 The remote control is an optional accessory and must be purchased separately.

 Effective operating distance of remote control: within 10 meters from the device

Screen Example

 Parameter Descriptions

 Parameter  Description

 Remote Control  

  

Turn on or turn off the function.

  

On: 

 Off: 

 Factory Reset

 

Factory reset function allows you to reset all the parameter settings of the device to factory 

defaults after the device update or when you think the parameters are improperly set.
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Screen Example

 Parameter Descriptions

 Parameter  Description

 

 

Reset the parameter settings to factory defaults, except for the Save IP

configuration file and communication parameter settings.

 

 

Reset the parameter settings to factory defaults, except for the input EDID, 

communication parameter settings, Fn, imported files and device name and 

restor

Keep User Data

e points.

 Reset All  Reset all the parameter settings to factory defaults.

 

 

Communication Settings

 

 

You can set the communication and network information to enable the device to communicate 

with the control PC smoothly.

Screen Example
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Operating Procedure

 

  

Step 1 On the main menu screen, rotate the knob to select Communication and press the knob to 

 

 

enter the communication settings screen.

Step 2 Select Network Mode and press the knob to confirm.

 

  

 

The options include Manual and Automatic.

 

 

 Manual: Set the device IP address, subnet mask and gateway manually.

 Automatic: The system automatically assigns an IP address for the device. When the device 

 

  

and control PC are connected to the same router or switch, set this option to Automatic.

Step 3 When the Manual option is selected, you must manually set the device IP address, subnet mask 

and gateway.

Step 4 Rotate the knob to select Apply to make the settings take effect; otherwise, select Reset to 

 reset the settings to defaults.

 

 

 

Rotate the knob to Reset and press the knob to confirm, and then all network parameters will be 

reset to defaults.
 

 

  

Device Working Mode

 

 

Three working modes are supported, including Video Controller, Fiber Converter and ByPass.

Screen Example
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Parameter Descriptions

 Table 5-4 Fiber converter

 Device Model  Description

 

 

  

Optical fiber ports are used for input, and Ethernet ports are used for VX400 Pro

output.

 

 





  

OPT 1~2 are used for input, and Ethernet ports are used for output.

OPT 1 serves as the primary connectors. The Ethernet ports 1~4 transmit 

OPT 1 data.

OPT 2 serves a s the backup connectors.

 

 

  

Optical fiber ports are used for input, and Ethernet ports are used for VX600 Pro

output.

 

 





  

OPT 1~2 are used for input, and Ethernet ports are used for output.

OPT 1 serves as the primary connectors. The Ethernet ports 1~6 transmit 

OPT 1 data.

 OPT 2 serves as the backup connectors.

 

 

  

Optical fiber ports are used for input, and Ethernet ports are used for VX1000 Pro

output.

 

 





  

OPT 1~2 are used for input, and Ethernet ports are used for output.

OPT 1 serves as the primary connectors. The Ethernet ports 1~10 transmit 

OPT 1 data.

 OPT 2 serves as the backup connectors.

 

 

  

Optical fiber ports are used for input, and Ethernet ports are used for VX2000 Pro

output.

 

 





  

OPT 1~4 are used for input, and Ethernet ports are used for output.

OPT 1 and OPT 2 serve as the primary connectors. The Ethernet ports 

1~10 transmit OPT 1 data, and Ethernet ports 11~20 transmit OPT 2 data.

 OPT 3 and OPT 4 serve as the backup connectors.

  Table 5-5 Video controller

 Device Model  Description

   

 

VX400 Pro 

 

 

OPT 1 can be used as an input or output connector depending on the 

connected devices.

OPT 1 sends the output on Ethernet ports 1~4. OPT 2 copies or backs up 

the output on Ethernet ports 1~4.

  

 

OPT 1 can be used as an input or output connector depending on the 

connect

VX600 Pro 

ed devices.
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 Device Model  Description

 

 

OPT 1 sends the output on Ethernet ports 1~6. OPT 2 copies or backs up 

the output on Ethernet ports 1~6.

  

 

VX1000 Pro 

 

 

OPT 1 can be used as an input or output connector depending on the 

connected devices.

OPT 1 sends the output on Ethernet ports 1~10. OPT 2 copies or backs up 

the output on Ethernet ports 1~10.

  

 

VX2000 Pro 

 

 

 

OPT 1 and OPT 2 can be used as an input or output connector depending 

on the connected devices.

OPT 1 and OPT 2 send the output on Ethernet ports 1~10 and 11~20 

respectively. OPT 3 and OPT 4 copy or back up the output on Ethernet 



ports 1~10 and 11~20 respectively.

  Table 5-6 ByPass

 Device Model  Description

 

VX400 Pro/VX600 Pro/VX1000 

Pro/VX2000 Pro  

Under this mode, the device works as an independent controller 

with no support for video processing functions.

 

 

OPT Mode

 

 

Supports settings of both the OPT working mode and loop mode.

Screen Example

 Hardware Connections

 The diagram takes the VX2000 Pro as an example.
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Figure 5-20 Copy mode

Figure 5-21 Backup between Ethernet and OPT ports
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Figure 5-22 OPT loop mode

 

 

Parameter Descriptions

 Table 5-7 OPT working mode

 Device Model  Parameter  Description

 VX400 Pro    

  

Copy: OPT 2 copies the output on Ethernet ports 1~4.

Backup: OPT 2 backs up the 

OPT 2

 output on Ethernet ports 1~4.

   

  

Copy: OPT 2 copies the output on Ethernet ports 1~6.VX600 Pro

 Backup: OPT 2 backs up the output on Ethernet ports 1~6.

   

 

 

Copy: OPT 2 copies the output on Ethernet ports 1~10.

Backup: OPT 2 backs up the output on Ethernet ports 

VX1000 Pro



1~10.

 VX2000 Pro   

 

OPT 3/4 

 

 

Copy: OPT 3 copies the output on Ethernet ports 1~10, 

and OPT 4 copies the output on Ethernet ports 11~20.

Backup: OPT 3 backs up the output on Ethernet ports 

1~10, and OPT 4 backs up the output on Ethernet ports 

11



~20.

  Table 5-8 OPT loop mode

 Device Model  Parameter  Description

 

VX400 Pro/VX600 

Pro/VX1000 Pro/VX2000 

Pro

 

 

Loop out the video signal accessed by OPT 1 via OPT OPT Loop

2 for device mosaic.

   : Enable the loop mode.
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 Device Model  Parameter  Description

   : Disable the loop mode.

 

 

 

 

About Us

 

 

Under this menu item, you can view the firmware version, device SN, official website and email 

address. On our official website, you can check the latest device information and the updates 

for this device. You can also send your feedback or suggestion to us for improvements via the 

supplied email address.

Screen Example

 Language

 

The language options include English, Simplified Chinese, Traditional Chinese, Hindi, Spanish, 

French, Portuguese, Russian, Japanese, Korean, German, Vietnamese, Turkish, Thai and 

Indonesian. You can switch to your preferred language.
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  Remote Control

 

Enable or disable the device standby mode, power on or power off the screen, adjust the screen 

brightness and output volume, switch presets, set the USB playback parameters, adjust the 

output image quality, switch layer input sources and set the 3D function through a remote 

control.

 

 

Button Descriptions

 

 

 

Figure 6-1 Remote control

 Table 6-1 Button descriptions

 No.  Description

   

 

 

Enable or disable the standby mode.

Connect a multifunction card and press this button to power on or power 

1



off the screen.

 

 

 

Press the button to adjust the brightness by step, and hold down the button 

for quick adjustment. Range: 0% to 100%, Step: 1

On the menu interface, the button can be used as the up/down 

2, 6

button.
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 No.  Description

  3, 5

 

Play the previous or next USB media file.

On the menu interface, the button can be used as the left/right button.

 4  Press the button to play the current USB media file or stop the playback.

  7  Press the button to enter the Settings interface.

 8  Return or exit button.

 9  Press the button to enter the preset switching menu.

 10  Press the button to increase the output volume.

 11  Press the button to decrease the output volume.

 

 

 

Insert the matching Bluetooth module into the USB 2.0 port on the device rear panel, and then 

simultaneously hold down the "6" and "8" buttons until the remote control's red light illuminates, 

so that the remote control is successfully paired with the device.
 

 

 

OSD Menu Descriptions

 

 

Figure 6-2 All settings
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Switch Presets

 

 

 

Figure 6-3 Interface example

 

 

Press the direction button to select the desired preset. After selection, press the OK button to 

load the selected preset.

Switch Layer Input Sources

 

 

Figure 6-4 Interface example

 

Press the direction button to select the desired layer and input source respectively. After 

selection, press the OK button to switch the input source of the selected layer.

 

 

USB Playback

 

 

Figure 6-5 Interface example
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  Table 6-2 Menu descriptions

 Menu  Description

  USB Player

 

Display the video and image file list.

Press the up/down button to select the desired file, and then press the OK 

button to play the selected file.

 

  

 

The supported parameters include Playback Mode, File Type, Image 

Playback Duration (s), Image Transition Effect, Image Trans Duration (s), 

Auto Playback and Resume Playback.

For detailed information, please refer to Playback Settings

Playback Settings

.

 

 

Select the desired media file, and then press the left/right button to adjust Sort

the sequence of the selected file displayed in the playback list.

 

 

Adjust Image Quality

 

 

 

Figure 6-6 Screen example

 Table 6-3 Menu descriptions

 Menu  Description

  Eye Comfort Mode  

  

Turn on or turn off this function.

  

On: 

 Off: 

  

  

Mode

 

The display mode of the output image

You can set the desired output mode based on the display content. The 

supported options include Standard (default), Document, Conference and 

Video.

 

When the eye comfort mode is disabled, you can customize and reset the 

 parameters of each mode.
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 Menu  Description

 Brightness  Brightness is the shading of lights in the image.

 

 

Contrast is the ratio of the luminance of the brightest color to that of the Contrast

darkest color.

  

 

Saturation is the colorfulness of the image. The higher the contrast, the Saturation

more vivid the image.

 Hue  The relative degree of how bright or dark the image is

 Color Temperature  Adjust the cool or warm degree of images displayed on the LED screen.

 

 

Adjust Brightness

 

 

 

Figure 6-7 Screen example

 

Press the left/right button to increase or decrease the screen brightness. After adjustments, 

press the direction button to select Save and press the OK button to automatically save the 

brightness parameter.

 

 

3D Settings

 

 

Figure 6-8 Screen example
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  Table 6-4 Menu descriptions

 Menu  Description

 Status  

  

Turn on or turn off the switch.

  

On: 

 Off: 

  

  

Source Format

 

The format of the 3D video source

Set the format to Side-by-Side, Top-and-Bottom or Frame Sequential

according to the format of the accessed video source.

 

 When the 3D function is enabled and the video source format is Side-by-Side

 or Top-and-Bottom, the device output capacity will be halved.

  Eye Priority

 

Set which image is sent first, the right eye image or the left eye image.

Put on the 3D glasses to view the screen. If the display appears abnormal, 

adjust the parameter value to the other one. If the display is normal, no 

further adjustments are needed.

 Third-Party Emitter  

  

Turn on or turn off the function.

  

On: 

 Off: 

 

 

Set the delay time of sending the synchronization signal from the 3D signal 

emitter to the 3D glasses. This setting ensures that the switching between 

left and right eye images of the 3D glasses is in sync with the switching 

between the left and right eye images on the screen. This parameter is 

applicable to both the NovaStar and third-

Emitter Delay

party emitters.

 

 

Adjust Volume

 

 

Figure 6-9 Screen example

 Press the left/right button to increase or decrease the volume.
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  Software Control

 

You can control the all-in-one video controller via both the Unico client software and webpage. 

Except for functions mentioned below, the other functions of the two operating terminals are 

the same. Here we take the operations on the client side as an example to illustrate.

 Function Module  Unico Client  Unico Webpage

 Cabinet library  Local pack, device pack  Device pack

 Software Installation and Connection

 Software Installation

 

  

 

Prerequisites

 

 The software package is obtained.

 A computer meeting the following requirements is prepared:

 

  

  

Windows:

  

Operating system: Windows 10 (64-bit) or later

CPU: 9th Generation Intel i7 processor or above

−

−

− Memory: 16 GB or above

 Mac OS: Mac OS 10.14 or above

 

 

Installation Method

 

 

Run the .exe file and follow the setup wizard to complete the installation. If a firewall prompt 

appears, choose to allow the installation.

Installation Result

 

After a successful installation, the Unico software icon is displayed on the desktop. Double-

click this icon to open the Unico software.

Need LED display solutions? Contact Chipshow: 
manager@chipshow.com | www.chipshow.com



 
 VX Pro Series All-in-One Controller User Manual

 

 

   92
 

 

 

 

Software Connection

 

 

 

The Unico software is installed on the control computer. The control computer can connect to 

the device in the following two ways:

 Via Ethernet cable

 

Connect the device and the control PC directly via Ethernet cable and set a static IP address 

for the device to let it and the control PC be on the same network segment.

 Via LAN

 

Connect the device and the control PC to the same LAN to ensure that both of them are on 

the same network segment.

 Project Management

 

Create, edit and dissolve projects. Project files (.uprj) can be exported from the current device 

and imported into others, promptly applying device parameters and resource files.

 

 

 

Create New Projects

 

Devices of the same series on a local network are automatically added to a default project. 

Users can create additional projects and move online devices from the default project to new 

ones. Furthermore, simulation projects can be created to simulate real device configurations 

and understand the product better.

Step 1 Open the software and access the main interface.
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Figure 7-1 Project

 

  

Step 2 Create an online project or simulation project.

 

 Online Project: Create a project for online devices. Select the Online Project tab at the top 

 

 

left and click New Project at the top right. Enter the project name in the popup window and 

click OK.

 

 

  

Figure 7-2 New projects

 

 

 

 

 

 Simulation Project: Create a project for simulation devices. Select the Simulation Project tab 

 

at the top left and click New Project at the top right. Enter the project name in the popup 

window and click OK.

After a simulation project is successfully created, please refer to Simulation Devices to add a 

simulation device.

For online projects, devices of the same series are automatically grouped under one project. 

When adding simulation devices, only devices of the same series can be included in a single 

project.

 

 In the project list area, you can perform the project-related operations.
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Edit project: Click Edit to rename the project.

Export project: Click Export to export the online project file. Simulation projects do not support 

exporting.

Dissolve project: Click Dissolve to dissolve the current project. All online devices in the project 

will be moved to the default project.

Enter project: Click Enter







 to enter the device configuration page.
 

  

 

 

  

 

Step 3 Move devices between projects.

 

 

  

Expand the project list, hover over the target device, and click Move or manually drag it to 

another project.

 Move: Choose the target project in the popup window, then click OK.

Figure 7-3 Move devices

  Manual drag: Manually drag to another project and click Yes in the popup window.

 

 Devices of the same series can only be added into one project.
 

 

 

    

Import Projects

Import the local project files (.uprj) to the device. Please note that the device models must 

match with the models in the project file.

Step 1 Select the Online Projects or Simulation Projects tab, and click Enter to access the device 

 configuration interface.

Need LED display solutions? Contact Chipshow: 
manager@chipshow.com | www.chipshow.com



 
 VX Pro Series All-in-One Controller User Manual

 

 

   95
 

    

  

Step 2 Navigate to File > Import from the menu bar.

Step 3 In the dialog box that appears, select a project file (.uprj) and click OK.

 

 Simulation project files can be imported into online projects.
 

     

  

Step 4 In the displayed Import Project File window, select Online Projects or Simulation Projects.

 

 

 

Figure 7-4 Import project files

 Step 5 After successful device matching, select the data to be imported and click OK.

The software matches the SN, name, IP address, model, and firmware version from the file with 

 the online or simulation device. Click  

  

 

to modify the match:

 For online devices, select other online devices from the drop-down menu.

 For simulation devices, choose to create a new simulation device. Ignore the current device, 

 or select another simulation device from the drop down menu.

 

  

    

Export Projects

Export the device project files to your local computer.

Step 1 Select the Online Projects or Simulation Projects tab, and click Enter to access the device 

 configuration interface.
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Step 2 In the menu bar, navigate to File > Export

Step 3 In the displayed dialog box, select the desired data.

 

 

  

 

Figure 7-5 Export project files

 

Step 4 Click Export.

Step 5 In the displayed dialog box, select a file path and click Save.

 

  

 

On the Online Projects interface, you can also click Export on the right side of the project list to 

export the project file.
 

 Device Management

 Enter Device Configuration Page

 

  

Online Devices

 Step 1 Select the Online Projects tab.
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Figure 7-6 Online project list (VX2000 Pro)

Step 2 Double click the device front panel image or click Enter on the right side of the project list to 

 access the device configuration interface.

 

 

   

 

Simulation Devices

 

Simulation devices, without any physical connections, simulate real device configurations, 

enabling users to easily utilize and understand the software.

Step 1 Select the Simulation Projects tab.

Step 2 Click Add simulation devices.

 

 

The device models supporting the simulation device function include the VX400 Pro and VX2000 

Pro.
 

  Step 3 In the pop-up dialog box, set the device name, model, and IP address, and click OK.

 

  

Once created, the device will be displayed in the list and will be in the default started state.

  

: The device is started.

 : The device is off.
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Figure 7-7 New simulation devices (VX2000 Pro)

 

 

  

  

  

  

  

For devices in the project list, you can perform the following operations:

 

 













  

Start all devices: Click Start All.

Shut down all devices: Click Shut Down All.

Shut down device: Click Shut Down.

Start device: Click Start.

Edit device: Click Edit.

Move device: For an active device, click Move, choose the target project in the popup window, 

and click OK.

Delete device: Click Delete .
 

  

  

Step 4 After creation, you can view the device status, name, IP address, and model.

 Double click the device front panel image or click Enter on the right side of the project list to 

 

  

access the device configuration interface.

 Hover over the device information to start, shut down, edit (modify device name, IP address), 

 

 

move, or delete the device.
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Configure Device Properties

 

 

Select the device on the left side of the device configuration interface, and then configure the 

device-related properties on the right pane.

Figure 7-8 Device properties (VX2000 Pro)

 

  Click Collapse to collapse the device list.
 

 Rename Device

 Change the device name.

 

 

Prerequisites

 

None

Notes

 None
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Interface Example

 Description

 Enter a name for the device in the text box next to Device Name.

 Switch Working Mode

 Switch the device working mode.

 

 

Prerequisites

 

 

None

Notes

 

 

Set the device working mode according to the on-site application and screen connections.

Interface Example

 

  

Description

 Select Video Controller, Fiber Converter or ByPass from the drop-down list.

 Configure IP Address

 

Manually set a static IP address for the device or let the device to automatically obtain an IP 

address.
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Prerequisites

 

 

None

Notes

 

 

Devices on different network segments are not automatically discovered. If you change the 

device IP to another network segment, the device could not be discovered.

Interface Example

 

 

Description

 Configure the following parameters and click Apply to make the settings take effect.

 Parameter  Description

 Network Mode  

  

Select the IP configuration method.

  

Manual: Manually set a static IP address for the device.

 DHCP: The device automatically obtains an IP address.

 IP Address  The device IP address

 Subnet Mask  The subnet mask of the IP address

 Gateway  The default gateway

 

 

Configure Sync Source

 

Select a sync signal to synchronize all the cascaded device units or synchronize the primary and 

backup devices to display the output images of all the units in sync.
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Prerequisites

 

 

None

Note

 

 

None

Interface Example

 Description

 Parameter  Description

 Sync To  

  

Select a sync source.

 

 

 





  

Internal Frame Rate: The frame rate of the output image

Input source connected to the device video connector: Sync with the frame rate 

of the selected input source.

"X" represents the input source number and its format may vary depending on 

the actual setup.

 Genlock: Sync with the frame rate of the Genlock signal.

 When the function is enabled, the frame rate of the sync source will be displayed.

 

 

When you select Internal Frame Rate, you can manually set the output frame 

rate. The default 

Frame Rate

value is 60Hz.

 

 

Configure HDCP

 

High-bandwidth Digital Content Protection (HDCP) is a form of digital copy protection to 

prevent copying of digital audio and video content as it travels across connections. When the 

accessed input source is an HDCP-encrypted one, you need to turn on this function to enable 

the device to transmit and process the source.
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Prerequisites

 

 

None

Notes

 

 

None

Interface Example

 Description

 Parameter  Description

 HDCP  

  

Turn on or turn off the function.

  

: On

 : Off

 Configure Date and Time

 Configure the time zone, date and time of the device.

 

 

Prerequisites

 

None

Notes

 None
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Interface Example

 

 

Description

 

Click Edit and the parameters become editable. Set the time zone, date and time respectively, 

and then click Apply.

 Reset to Factory Settings

 Reset the device data and settings to factory default values.

 

 

Prerequisites

 

  

  

  

  

None

Notes

 

 

 Please do this with great caution.

 The reset action does not affect the device firmware version.

 Power-off is not allowed during the reset process.

 The device will restart automatically after the reset is completed.

Interface Example
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Description

 

 

 

Select Retain user data, Retain IP only or Reset all, and then click Apply.

 Retain user data

 

 

 

Retain the input EDID, imported files, language, device name, device IP, belonged project 

and restore points.

 Retain IP only

 

Only retain the device IP address and reset other parameters to factory defaults.

 Reset all

 Reset all parameters.

 Standby Mode

 

Enabling standby mode can effectively reduce energy consumption caused by screen heat 

generation.

 

 

Prerequisites

 

 

None

Notes

 

 

Once the standby mode is enabled, the output image will go black and the output volume will 

be adjusted to 0. The device LCD screen will also be locked, while other parameters remain 

unchanged.

Interface Example

 Description

 Parameter  Description

 Standby Mode  Turn on or turn off the function.

   : On
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 Parameter  Description

   : Off

 Restart Device

 Restart the device.

 

 

Prerequisites

 

 

None

Notes

 

 

None

Interface Example

 

 

Description

 Click Restart, and then click Yes in the displayed dialog box.

 Configure Input Source Backup

 Establish a backup relation for two input sources.

 

 

Prerequisites

 

 

 

None

Notes

 

Input backup rules:

 In each backup group, two input sources serve as the backup for each other.
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 The backup relation can only be established if the input connectors have identical capacities.

 The USB source supports the input backup settings.

 Each primary or backup source can have only one backup or primary source.

 Restrictions on input backup functions:

 

Input sources A and B form a hot backup group. The current input source of the layer is 

input source A.

  

 

 

−

  

 

−

  

 

−

  

 

Input A: No signal. Input B: Signal

The layer input source is switched to input B automatically. When input A resumes and 

input B still has a signal and Primary Source Preferred is not enabled, the layer input 

source will not be changed.

Input A: No signal. Input B: Signal

The layer input source is switched to input B automatically. When input A resumes, but 

input B does not have a signal, the layer input source will be changed to input A.

Input A: No signal. Input B: No signal

The layer input source will not be changed.

Input A: Signal. Input B: No signal

If you manually switch the layer input source to input B, the source will automatically 

−

switch to input A.

 

 

 

   

  

Interface Example

Description

Step 1 Select the Input Source Backup tab.

Step 2 Toggle the switch next to Backup Status to  

 

.

 Step 3 Select or deselect Primary Source Preferred.
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   If Primary Source Preferred is enabled, the system will automatically switch to the primary 

 

  

source once it is restored.

 

   

 

 If Primary Source Preferred is disabled, the system will not automatically switch when the 

primary source is restored and will continue using the backup source.

Step 4 Click Add to add a backup relationship.

Step 5 Select a primary source and a backup source respectively from two drop-down lists to establish 

 a hot backup pair.

 The green dot  

  

indicates the source is accessed normally and ready for use.

 

 

 To delete a hot backup pair, click 



next to the pair and click Delete.

To delete all hot backup pairs, click  .

 

 

 

Configure Input Properties

 

 

Click the target input connector on the graphical device rear panel, and then set the input-

related properties in the property area on the right pane.

Figure 7-9 Input properties (VX2000 Pro)

 View Input Source Info

 View the basic properties of the input connector and change the input connector name.
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 Prerequisites

 A fine signal is connected to the input connector.

 

 

Notes

 

 

None

Interface Example

 

 

Description

 On the Basic tab interface, change the connector name as required.

 

 

Hover the mouse over the target input connector, you can view the input source resolution, frame 

rate, bit depth and color/sampling rate.
 

 View OPT Source Info

 View the basic properties of the OPT source and change the OPT port name.

 

   

 

Prerequisites

 The device working mode is set to Video Controller.

 OPT 1 and OPT 2 is connected to the OPT ports on the front-end video processor via optical 

 fiber cables. Additionally, a fine signal is connected to the front-end device.
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Notes

 

 

Each OPT support the transmission of 1x DL or 2x SL sources.

Interface Example

 

 

Description

 On the Input Source tab interface, change the connector name as required.

 Set Input Connector Capacity

 Switch the input connector capacity as desired.

 

 

Prerequisites

 

 

None

Interface Example

 

 

When a connector is configured for hot backup, you can no longer switch its capacity.

Interface Example
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 Description

 Capacity  Description

   

  

  

Standard resolution: 1920×1080@60Hz

Custom max width: 2048 (2048×1080@60Hz)





SL

 Custom max height: 2048 (1080×2048@60Hz)

   

  

  

Standard resolution: 3840×1080@60Hz/3840×2160@30Hz

Custom max width: 4096 (4096×1080@60Hz)





DL

 Custom max height: 3840 (1080×3840@60Hz)

   

  

  

Standard resolution: 4096×2160@60Hz/8192×2160@30Hz

Custom max width: 8192 (8192×1080@60Hz)

Custom max height: 8188 (108





4K

 0×8188@60Hz)

 Configure Input HDCP

 Enable or disable the input HDCP encryption.

 

 

Prerequisites

 

 

None

Notes

 

 

None

Interface Example

 

 

Description

 

For an HDCP source, it can only be properly recognized if the HDCP function on the input end is 

enabled; if the input HDCP is disabled, the HDCP source will by default display a black screen or 

snow.

For a non-HDCP source, whether the HDCP function on the input end is enabled or not does 

not affect the normal transmission of the source image into the device.
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 Configure InfoFrame Override Parameters

 

Configure the InfoFrame override parameters of the input source, so that the device can use it 

when doing some calculations. This action does not change the parameter values that come 

with the input source.

 

 

Prerequisites

 

 

None

Notes

 

 

None

Interface Example (VX2000 Pro)

 

 

Description

 On the Basic tab interface, configure the following parameters.

 Parameter  Description

 

Color 

Space/Sample

 The sampling format of the input

 Bit Depth  The bit depth of the input, i.e., the binary digits to represent a single color

 

Quantization 

Range

 The quantization range of the input

 Gamut  The color gamut standard

  Select From Input and the device will read the attribute values that come with the input source.
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Set HDR

 

HDR is the abbreviation for High-Dynamic Range. HDR function can greatly enhance the display 

image quality, allowing for a more clear and vivid image when the device is used together with 

the specified receiving cards.

 

  

 

Prerequisites

 

 Use the layer 1 source as an HDR source.

 An HDR source (HDR10/HLG standard) must be used to realize optimal HDR effect.

 

  

  

 

Notes

 

 An HDR source can be connected to the HDMI 2.0 or 12G-SDI connector only.

 The HDR and 3D functions cannot be used together.

 Using the HDR function paired with receiving cards of different models will reduce the 

 

 

device loading capacity by half or quarter because the HDR input source is 10-bit. Please 

work out a connection solution in advance.

Interface Example

 Description

 Parameter  Description

  

 

Dynamic Range

 

The dynamic range of an HDR source

The supported options include HDR10, HLG, off

and From Input.

 

After the HDR source parameters are successfully set, you need to adjust EOTF. For detailed 

operations, please refer to Adjust EOTF.
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When you enable the HDR function, the receiving card supporting this function should be used 

together. For the specified receiving card model and related information, please refer to our 

official website ( www.novastar.tech).
 

 

 

Configure EDID

 

  

 

Configure the resolution and frame rate of the input. You can select the standard resolution 

provided by the device, customize a resolution, or set the advanced parameters.

 

Prerequisites

 

 

 SDI does not support this function.

 The front-end device outputs the video source from the graphics card.

 

 

Notes

 

 

 

It is recommended the advanced settings be carried out by the trained personnel only.

Interface Example

 

 

Figure 7-10 Standard

Figure 7-11 Custom
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Figure 7-12 Advanced

 

Description

On the EDID tab interface, select the Standard, Custom or Advanced mode, configure the 

following parameters, and then click Apply after the settings.

 Mode  Parameter  Description

   

 

Mode Three modes are supported, including Standard, Custom or 

Advanced

-

.

   

 

 

 

Standard

 

Resolution The number of horizontal pixels and vertical pixels of the image

Check the box next to Display Resolution Details to display the 

resolution detailed information.

Config method: Select the desired resolution from the drop-down 

list.

  

 

Frame Rate The image frames every second (unit: Hz)

Config method: Select the standard common frame rates from the 

drop-down options. The available frame rates may vary according 

to the chosen resolution.

   Custom

 

Resolution The number of horizontal pixels and vertical pixels of the image

Config method: Stet the width and height values respectively.

  

 

Frame Rate The image frames every second (unit: Hz)

Config method: Select the standard common frame rates from the 
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 Mode  Parameter  Description

 

drop-down options. The available frame rates may vary according 

to the chosen resolution.

  Advanced  H Total Total pixel count per line

  H Active The horizontal size in pixels of the active area

 

 

The offset between the end of the active area and the beginning of H Front Porch

the H sync

  H Sync The horizontal sync width in pixels (or between pixels)

  H Polarity The polarity of the horizontal sync pulse

  V Total Total pixel count per column

  V Active The vertical size in pixels of the active area

 

 

The offset in lines between the end of the active output area and V Front Porch

the beginning of V sync

  V Sync The vertical sync width in rows (or between rows)

  V Polarity The polarity of the vertical sync pulse

  

 

Frame Rate The image frames every second (unit: Hz)

Config method: Select the standard common frame rates from the 

drop-down options or set the frame rate value.

 

 

Configure Compatibility with Mac

 

 

When the device is incompatible with the EDID of a Mac system, you may activate this feature 

to resolve the issue.

 

Prerequisites

 

None

Notes

None
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Interface Example

 Description

 Parameter  Description

 Mac EDID Compatibility  

  

Turn on or turn off the function.

  

: On

 : Off

 Import and Export EDID

 

When compatibility problem occurs on an input connector, import an intact EDID file into the 

device; or export an EDID file from a device and provide the EDID file to other devices or input 

connectors to solve the compatibility issues.

 Prerequisites

 SDI does not support this function.

 

  

 

Notes

 

 Each input connector supports importing one EDID file only.

 Once the EDID file is imported, the input connector will recognize and apply the parameters 

 

 

from the file.

Interface Example
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Description

 

 

 

 

 EDID Import

 

 

On the EDID tab interface, click EDID Import. In the dialog box that appears, select an EDID 

file and click Open.

 EDID Export

 

On the EDID tab interface, click EDID Export. In the dialog box that appears, select a path 

and click Save.

 

 

If you need to modify the content of an imported EDID file, just modify it and then re-import it to 

overwrite the original one.
 

 Configure Output Properties

 Set OPT Ports

 Set the OPT working mode and loop mode.

 Prerequisites

 The device working mode is set to Video Controller.

 

 

Notes

 

 

None

Interface Example

 Description

 Click the OPT port on the device rear panel, and then set the following parameters.

Need LED display solutions? Contact Chipshow: 
manager@chipshow.com | www.chipshow.com



 
 VX Pro Series All-in-One Controller User Manual

 

 

   119
 

  Table 7-1 OPT working mode

 Device Model  Parameter  Description

 

 

 

  

OPT 2 Working VX400 Pro

Mode

 

  

OPT 2 working mode

Config method: Select Copy or Backup from the drop-down 

list.

  

Copy: OPT 2 copies the output on Ethernet port 1~4.

Backup



 : OPT 2 backs up the output on Ethernet port 1~4.

  

  

VX600 Pro

 

  

OPT 2 working mode

Config method: Select Copy or Backup from the drop-down 

list.

  

Copy: OPT 2 copies the output on Ethernet port 1~6.

Backup



 : OPT 2 backs up the output on Ethernet port 1~6.

  

  

VX1000 Pro

 

  

OPT 2 working mode

Config method: Select Copy or Backup from the drop-down 

list.

  

 

Copy: OPT 2 copies the output on Ethernet port 1~10.

Backup: OPT 2 backs up the output on Ethernet port 





1~10.

 

 

 

  

OPT 3/4 Working VX2000 Pro

Mode

 

OPT 3 and OPT 4 working modes

Config method: Select Copy or Backup from the drop-down 

list.

 

 



 

 

Copy: OPT 3 and OPT 4 copy the output on Ethernet port 

1~10 and 11~20 respectively.

Backup: OPT 3 and OPT 4 back up the output on Ethernet 

port 1~10 and 11~20 respectively.

 

 

 



 

 

After the OPT working mode is set to Copy, the OPT ports on the graphical device panel will be 

highlighted.

After the OPT working mode is set to Backup, the backup icons will be displayed at the bottom 

right corner of the OPT ports on the graphical device panel.
 

  Table 7-2 OPT loop mode

 Device Model  Parameter  Description

 

VX400 Pro/VX600 

Pro/VX1000 

Pro/VX2000 Pro

 OPT Loop Mode  Turn on or turn off the function.

   On: 
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 Device Model  Parameter  Description

 

  

After this function is enabled, the video signal accessed 

by OPT 1 will be looped out via OPT 2.

 Off: 

 Set Monitoring

 

Real-time display of the output image via the monitor connected is supported. You can monitor 

whether the output is normal and adjust the display ratio of the monitoring image on the 

monitor to avoid image distortion.

 

 

 

Prerequisites

 

 

None

Notes

Interface Example (VX2000 Pro)

 

 

Description

 Click the Monitor connector on the device rear panel, and then set the following parameters.

 Parameter  Description

   Scaling Mode  

  

The options include Keep Ratio and Full Screen (default).

  

Keep Ratio: Keep the ratio of the original output image to display.

 Full Screen: Display the output image in full screen.

 

 When Keep Ratio is selected, the blank area that the output image cannot 

 cover the entire monitor screen will be automatically filled with solid black.

  Definition  The supported options include Smooth and High-Definition.
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 Parameter  Description

  

  

Smooth: The monitoring image definition is 1920×1080@60Hz.

High-



 Definition: The monitoring image definition is 3840×2160@60Hz.

 Screen Configuration

 Configure Sub-Screens

 

When a single device is used to load to multiple physical screens (for example, to display the 

same or different content simultaneously on multiple welcome screens or information screens), 

the sub-screen function can be enabled. By configuring an independent sub-screen for each 

physical screen, their display effects can be controlled separately.

 Add Sub-Screens

 

Configure an independent sub-screen for each physical screen, allowing for independent 

control of the images and effects on each screen.

 

 

Prerequisites

 

 

None

Notes

 

 

Up to 5 sub-screens can be created.

Interface Example
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Description

 

Click Sub-Screen at the top right corner, and then click New Sub-Screen in the popup menu to 

add a sub-screen. The default name is Sub-Screen 1.

 

 

If you have configured the screen topology before adding a sub-screen, the configured cabinets 

will be automatically assigned to the first created sub-screen by default.
 

 

  

In the sub-screen list, you can perform the following operations.

 Change name: Hover the mouse over the target sub-screen, and then click that appears. 

 

 

Enter a new name, and then click elsewhere in the interface to complete the sub-screen 

name change.

  Delete sub-screen: Hover the mouse over the target sub-screen, and then click 

 

that 

 appears. In the popup dialog box, click OK to delete the sub-screen.

 

 

 

 

 When deleting a sub-screen, its configured cabinets will also be deleted. Please proceed 

 

with caution.

 When deleting the last sub-screen, its screen topology will be saved to the initial screen.
 

 Set Sub-Screens

 

For a sub-screen, you can perform related operations, including screen topology configuration, 

cabinet correction and screen adjustment, realizing independent control of each physical 

screen.

 

 

Prerequisites

 

 

None

Notes

 If you use the quick configuration function to configure the LED screen on the device LCD 

 panel, all sub-screens created in Unico will be cleared.
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 You can add, delete or rename a sub-screen on the Screen interface only. For switching or 

 

configuring the sub-screen, please perform the related operations on the Correction or 

Screen Settings interface.

 

 

Interface Example

 

  

  

Description

 

Click Sub-Screen at the top right corner, and then select the target sub-screen to switch to it.

After switching to the target sub-screen, you can configure the screen topology, correct the 

cabinet and adjust the screen on the Screen, Correction or Screen Settings interface 

respectively. For detailed operations, please refer to the related sections in this manual.

 

  

 

   

 On the Screen interface, cabinets configured for all sub-screens will be displayed, and the 

 

   

cabinets of the current screen will be displayed at the top and can be selected; while, 

cabinets of other sub-screens will be displayed in gray at the bottom and cannot be 

selected.

 On the Correction and Screen Settings interfaces, only cabinets of the current sub-screen 

 

will be displayed.

 On the Screen Settings interfaces, click Sub-Screen at the top right corner, and then select 

 

All in the popup menu to adjust the related parameters, such as brightness and Gamma, for 

all sub-screens.
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 Configure Screen Topology

 

Configure the cabinet topology to complete the wiring connections of the physical or empty 

cabinets.

 Configure Online Cabinets

 Prerequisites

 The device is connected and cabinets are connected to the device.

 

 

Notes

 

  

None

Description

 

 

Step 1 Click Screen at the top to enter the screen configuration interface.

 

 

  

  

Figure 7-13 Screen configuration (VX2000 Pro)

Step 2 Select the desired screen from the screen list on the left.

Step 3 In the Ethernet Port List area, select an Ethernet port and then drag and click the mouse in the 

 topology area to add cabinets.
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The cabinets will be automatically connected when you are adding them, as shown in Figure 7-

14. The Ethernet port's loading capacity information will be displayed, as shown in Figure 7-15.

Figure 7-14 Cabinets connected automatically

 

 

  

 

Figure 7-15 Ethernet port capacity

 

 

 1: The Ethernet port number

 2/8: Configured cabinets loaded by this Ethernet port/Total cabinets loaded by this Ethernet 

port

 20% and progress bar: Loading capacity used by the configured cabinets/Total loading 

 capacity of this Ethernet port

 

 Descriptions for shortcut keys:

  

 



 

 

Batch select cabinets: Hold the Shift key and drag with the left mouse button to select, or 

simply drag the mouse to select multiple cabinets at a time.

When no Ethernet ports are selected, use the arrow keys to finely adjust the position of the 

selected cabinet. Each press moves the cabinet by 1 pixel.

 Description for Swift Layout:

 

 

 

Requirements: If all the cabinets loaded by the Ethernet ports have the same model, resolution, 

and connection topology, you can use the Swift Layout function to quickly add and connect 



the cabinets for all the Ethernet ports.

   Operating procedure: Click and then drag the mouse in the topology area to add 

 

cabinets that match the actual requirements. In the properties area, select a layout and click 

Done.
 

  Step 4 Select other Ethernet ports and continue to add cabinets until all cabinets are connected.
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 The configured cabinets can be rewired by selecting other Ethernet ports to load them.
 

 

  

 

Step 5 For cabinets that have the same size and consecutive serial numbers, if you want to change the 

 

 

 

cabinet connection topology, select the cabinets and then select a quick topology under Quick 

topo in the properties area, as shown in Figure 7-16. For other cabinets, skip this step.

Figure 7-16 Quick topology

 

 

Step 6 Do any of the following to arrange and align the cabinets and cabinet groups to let the cabinet 

 

 

 

 

 

positions meet the display requirements.

 Use the function buttons.

 

Zoom to Selection: The selected element is zoomed and displayed in the center of the 

canvas.

Auto Fit: The canvas size is automatically adjusted to fit the topology area size.

  

−

−

−

 

 

Click to show its drop-down menu shown below. The menu can be used to set the 

canvas grid.

), a grid is displayed on the canvas. If you do not need to 

 

 

Grid: When toggled on (

display the grid, set the switch to .

Grid Color: Set the grid color.
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Grid Spacing: Set the spacing of horizontal and vertical lines of the grid. The spacing is 

set to the resolution of the first cabinet by default.

Snap to Cabinet: When positioning a cabinet near another one, the cabinet being 

moved will automatically align and snap to the edge of the adjacent cabinet, effectively 

eliminating gaps.

Snap to Grid: The cabinet will be snapped to the grid.

 Use the right-click function menu

  

  

−

−

−

−

−

−

  

 

  

   

−

  

 

 

Select String: Select all the cabinets on the connection line of the current cabinet.

Select Same Cabinets: Select the cabinets of the same model of the current cabinet.

Blackout: Blackout the output image displayed on the current cabinet.

Freeze: Freeze the output image displayed on the current cabinet.

Swap: Swap the positions of the two selected cabinets.

Group: Select the desired cabinets and right click on them. Click Group in the context 

menu, and then the selected cabinets will be grouped for batch control. To set the 

group name and color, please select the group and set them in the properties area. You 

can also use the keyboard shortcuts Ctrl+G to perform the grouping operation.

Ungroup: Ungroup the cabinets. You can also use the keyboard shortcuts Ctrl+Shift+G

to perform this action.

Add to: Add the selected cabinets to a group.

Clear Topology: Clear the current cabinet topology.

Delete: Delete the selected cabinet. You can also use the keyboard shortcuts Del to 

−

−

−

perform this action.

  Right click on the canvas edge and use the function menu
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−

 

 

  

−

−

−

−

−

  

 

 

 

 

−

−

 

 

  

−

  

Zoom to Selected: The selected element is zoomed and displayed in the center of the 

canvas.

Fit Screen: The canvas size is automatically adjusted to fit the topology area size.

Zoom 1:1: The canvas size equals the input source resolution.

Display Grid: Display a grid on the canvas.

Snap to Grid: The cabinet will be snapped to the grid.

Snap to Cabinet: When positioning a cabinet near another one, the cabinet being 

moved will automatically align and snap to the edge of the adjacent cabinet, effectively 

eliminating gaps.

Display Topology: Display the cabinet connections.

Display Status: Display the cabinet status.

Green: The cabinet is in the topology area.

Gray: The cabinet is offline.

Orange: Some part of the cabinet is in the topology area.

Red: The entire cabinet is out of the topology area.

Display Cabinet Color: Display a color icon at the top right corner of an Ethernet port. 

Once an Ethernet port is loading cabinets, a color icon will be displayed which is of the 

same color as the cabinet color.

Display Group Name: Display the cabinet group name.

Display 

−

− Overlapping Cabinets: Display the overlapping cabinets.
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Figure 7-17 Online cabinet topology (VX2000 Pro)

 

  

 

 

   

    

 

   

 

Use either Unico or NovaLCT to configure the screen.

Mapping is used to show the relations between the cabinets of the LED screen and the 

sending devices so that you can view or check the connections between the cabinets.

Click LCT Lite to run the software in which you can configure the receiving card parameters.

In the menu bar, go to File > Export Screen Config File to export the configured cabinet

topology as a file (.scr).

In the menu bar, go to File > Import Screen Config File to import a saved screen configuration 











file for quick topology.
 

 Configure Empty Cabinets

 

 

Prerequisites

 

None

Notes

 None
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Description

 

 

Step 1 Click Screen at the top of the page to enter the screen configuration page.

 

 

  

 

Figure 7-18 Screen configuration (VX2000 Pro)

 

 

Step 2 Select the desired screen from the screen list on the left.

Step 3 Click Add Cabinet.

 

 

  

Figure 7-19 Add cabinets

 

 

Step 4 Select the desired cabinet existing in the cabinet library from the drop-down list below Select 

 

   

 

Mode.

Step 5 (Optional) If no cabinet configuration files (.rcfgx) are imported to the cabinet library, you can 

 

set the width and height for the empty cabinet.

Step 6 Set the rows and columns of cabinets. After settings are done, click OK to confirm.

Step 7 In the topology area, click the left mouse button to add cabinets with the set rows and columns.
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Figure 7-20 Add empty cabinets (VX2000 Pro)

Step 8 Select the desired Ethernet port and drag or click the mouse in the empty cabinets to complete 

 the wiring.

 

 Descriptions for screen topology:

  

 

 

 



  

 



  

 



  

 

Use format painter.

Method I: Select an Ethernet port first, and then select the desired data flow. The cursor will 

change to a format painter icon. Drag the mouse in the empty cabinets to automatically 

complete the wiring according to the selected data flow.

Method II: Select the desired data flow first, and the cursor will change to a format painter 

icon. Then, select an Ethernet port and drag the mouse in the empty cabinets to complete

the wiring according to the selected data flow.

Drag the mouse to complete the wiring.

After selecting an Ethernet port, there is no need to choose the data flow. Simply drag the 

mouse in the empty cabinets, and the system will automatically complete the wiring 

according to the mouse movement.

Quick topology

Select one or multiple empty cabinets, select the desired data flow, and then select the 

target Ethernet port to complete the wiring.

Use arrow keys.

Select an Ethernet port and confirm the wiring starting position, and then use arrow keys to 



control the wiring path.
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Step 9 Select other Ethernet ports and continue wiring until all cabinets are connected.

 

 

 

   

  

 

Figure 7-21 Empty cabinet topology (VX2000 Pro)

 

Cabinet connection status:

 P1: The cabinet is loaded by Ethernet port 1.

 NC: An empty cabinet

Step 10 Connect the on-site cabinets based on the configured topology.

 

 

 

When configuring the empty cabinet, you can leave the desired cabinet without wiring as shown 

below based on the on-site screen loading requirements.

 

 Configure Screen Properties

 Set the screen-related properties in the property area on the right pane.
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 Rename Screens

 Change the screen name.

 

 

Prerequisites

 

 

None

Notes

 

 

None

Interface Example

 

 

Description

 On the Basic tab interface, change the screen name as required.

 Configure Low Latency

 

When the input source travels from where it comes to the processing device, sending device 

and then the receiving card, latency exists inevitably. Turning on this function can effectively 

help to reduce the latency from the input to output.

 

 

Prerequisites

 

None

Notes

 

If you set the low latency mode to Auto, the system will determine whether to enable the low 

latency based on the screen topology. The specific rules are as follows.
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  For a single Ethernet port with vertical cabling and no overlap in the Y direction, the low 

 

latency will be automatically enabled if all the following requirements are met; otherwise, it 

will be disabled.

 

 

−

 

 

−

  

 

 

The cabinets loaded by one Ethernet port cannot be overlapped, while blank 

configurations are allowed.

The circumscribed rectangles of all cabinets loaded by Ethernet ports must be aligned 

at the top of the canvas.

− No need to keep the same cabinet size.

 For free topology, the low latency will be automatically enabled if all the following 

 requirements are met; otherwise, it will be disabled.

 

 

−

 

 

−

  

The cabinets loaded by one Ethernet port cannot be overlapped, while blank 

configurations are not allowed.

The circumscribed rectangles of all cabinets loaded by Ethernet ports must be aligned 

at the top of the canvas. The size of the circumscribed rectangle cannot exceed 650,000 

pixels.

− The size of all cabinets must be the same.

 

 

Interface Example

 Description

 Parameter  Description

 Low Latency  Turn on of turn off the function.

   Off: Turn off the function. (Default option)
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 Parameter  Description

   On: Turn on the function. The device latency can be reduced by 1 frame.

 

After you manually enable the low latency function, it is advisable to align the 

circumscribed rectangle loaded by each Ethernet port at the top of the canvas. If 

not aligned, the loading capacity will be reduced. For calculating the actual loading 

capacity, please refer to Loading Capacity Calculation Method in Low Latency 

 Mode.

 

 

Auto: If you set the low latency mode to Auto, the system will determine 

whether to enable the low latency based on the screen topology. If the wiring 

meets the rules, low latency will be enabled automatically; otherwise, it will be 

disabled automatically. For specific rules, please refer to the notes in this 



section.

 Set Canvas Size

 

 

Prerequisites

 

 

None

Notes

 

 

None

Interface Example

 

 

Description

 On the Basic tab interface, configure the following parameters.

 Parameter  Description

 Resolution  The size of the canvas, that is the size of the device effective loading area

Need LED display solutions? Contact Chipshow: 
manager@chipshow.com | www.chipshow.com



 
 VX Pro Series All-in-One Controller User Manual

 

 

   136
 

 Parameter  Description

 

  

Config method:

  

 

 

Select the desired resolution from the drop-down list.

Select Custom from the drop-down list, and then set the width and height 





values.

 

Generally, the size of the effective loading area should match with that of the 

physical screen.

After you complete the settings, the system will automatically calculate the max 

output frame rate at the current resolution.

  

 

After the screen configuration is completed, click Match Screen and the system 

will automatically change the canvas size to the size of the circumscribed 

Match Screen

rectangles.

 Configure Test Patterns

 

Test patterns are used to check the connection relation between the output connectors and the 

screen, and check whether the screen display is good.

 

 

Prerequisites

 

None

Notes

 None
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Interface Example

 

 

Description

 On the Basic tab interface, configure the following parameters.

 Parameter  Description

 Test Pattern  

  

Turn on or turn off the function.

  

: On

 : Off

 After the function is enabled, select the desired test pattern.

 Grayscale  Set the grayscale of the test pattern.

  Spacing Level

 

Set the spacing between different color areas.

If a multi-color test pattern is selected, this parameter is available.

  Spacing (px)

 

Set the spacing between the lines.

If a grid test pattern is selected, this parameter is available.

 Grid Width  Set the width of the grid lines.

 Speed  Set the moving speed of the lines.
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 Configure Output Color

 Configure the output color parameters.

 

 

Prerequisites

 

 

None

Notes

 

 

None

Interface Example
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Description

 On the Effect tab interface, configure the following parameters.

 Parameter  Description

  Contrast

 

The ratio of the luminance of the brightest color to that of the darkest color

Adjust the contrast value either as a whole or individually adjust the RGB 

components.

  Brightness

 

The shading of lights in the image

Adjust the brightness value either as a whole or individually adjust the RGB 

components.

 Hue  The relative degree of how bright or dark the image is

  Saturation

 

The color purity of the image

The higher the value, the more vivid the color.

 Configure Cabinet Properties

 View Cabinet Library

 

 

Prerequisites

 

None

Notes

 None
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Interface Example

 

 

 

Description

 

View the online cabinets or cabinet configuration files in the cabinet library.

Click Add to upload the cabinet file to the local pack or device pack, or add the virtual cabinet 

to the local pack. For detailed operations, please refer to Manage Cabinet Library.

 Change Cabinet Resolutions

 

 

Prerequisites

 

 

None

Notes

 

 

The changed resolution of the configured cabinet should be a multiple of the module resolution 

to ensure normal display.

Interface Example
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Configuration

 

Select the desired cabinet in the canvas area, and then set the cabinet width and height on the 

Cabinet Properties tab interface. After settings are done, click OK to complete the editing.

 View Cabinet Info

 View cabinet-related info.

 

 

Prerequisites

 

 

None

Notes

 

 

None

Interface Example

 Description

 None

Need LED display solutions? Contact Chipshow: 
manager@chipshow.com | www.chipshow.com



 
 VX Pro Series All-in-One Controller User Manual

 

 

   142
 

 Configure Cabinet Groups

 Change the cabinet group name and background color.

 Prerequisites

 A cabinet group has been created.

 

 

Notes

 

 

None

Interface Example

 

 

Description

 On the Cabinet Properties tab interface, configure the following parameters.

 Parameter  Description

  Group

 

The name of the cabinet group

Config method: Enter a new group name, and then click elsewhere in the 

interface to complete the group name change.

  

 

Color

 

The background color of the group name

Config method: Click the color block next to Color, and then select a standard 

color or enter RGB values to set the background color of the cabinet group name.

 Configure Cabinet Positions

 Prerequisites

 None

Need LED display solutions? Contact Chipshow: 
manager@chipshow.com | www.chipshow.com



 
 VX Pro Series All-in-One Controller User Manual

 

 

   143
 

 Notes

 

The cabinet rotation in 90° increments feature is only supported by certain models of receiving 

cards, as detailed below:

 Model  Description

 CA50E, XA50Pro, A10s Pro  Supported by all versions.

 A8s-N, A7s Plus, A5s Plus  Supported by V4.9.0.0 or later.

 

 

Interface Example

 

 

Description

 On the Cabinet Properties tab interface, configure the following parameters.

 Parameter  Description

 Coordinate  

  

The position of the cabinet on the canvas

  

X: X coordinate of the cabinet on the canvas

 Y: Y coordinate of the cabinet on the canvas

 

 

 

Rotate the cabinet. Once the cabinet is rotated, the input source will display at 

the adjusted angle.

Rotation (0°)

Supported rotation angles: 0°, 90°, 180° and 270°

 Set Cabinets

 

 

Prerequisites

 

None

Notes

 None
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Interface Example

 

 

Description

 On the Cabinet Properties tab interface, configure the following parameters.

 Parameter  Description

 Blackout  

  

Turn on or turn off the function.

  

: On

 : Off

 Freeze  

  

Turn on or turn off the function.

  

: On

 : Off

 Indicator  

  

Turn on or turn off the function.

  

: On

 : Off

 Light up slowly  

  

Turn on or turn off the function.

  

: On

 : Off

 

Once enabled, the display brightness will slowly change from 0 to the target value 

after the screen is powered on.

 Test Pattern  Select a test pattern to perform screen aging test and troubleshoot problems.

 No data signal  

  

Set the display image after the Ethernet cable is disconnected.

  

Blackout: The screen displays a black image.

 Previous Frame: The screen always displays the last frame.
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 Configure Ethernet Port Backup

 

Test whether the pre-stored images, backup Ethernet ports and devices take effect without 

plugging and unplugging the Ethernet cables.

 Prerequisites

 

The pre-stored images, primary and backup Ethernet ports or primary and backup devices have 

been configured.

 

 

Notes

 

 

None

Interface Example

 

 

Description

 On the Cabinet Properties tab interface, configure the following parameters.

 Parameter  Description

 Port Backup  

  

Turn on or turn off the function.

  

: On

 : Off

 Backup Verify  

 

 

 

 

 

 

Select the desired backup test.

 

 

Off: Enable the output of all the Ethernet ports on the current device to 

complete the test.

Backup: Disable the output of the primary Ethernet port on the current device 

to test whether the backup port or device takes effect.

Primary: Disable the output of the backup Ethernet port on the current device 

to test whether the output of the primary port is normal.

Disconnect All: Disable the output of all the Ethernet ports on the current 

device to test whether the pre-









stored image takes effect.
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 After enabling Ethernet port backup, a icon is displayed between the primary and backup 

 

ports in the Ethernet port list. By default, the first half of the ports serve as backups for the 

second half.
 

 Set Dual RV Cards Backup

 

Receiving card backup allows you to set the backup relationship between two receiving cards. If 

the primary receiving card link fails, the backup one will take over the responsibilities of the 

primary receiving card and continue to work well to ensure the LED screen will not go black.

 Prerequisites

 Two receiving cards are connected to the cabinet.

 

 

Notes

 

 

When you enable both the device backup and dual receiving cards backup, the former takes 

precedence over the latter. When the layer sources of two devices are disconnected, the device 

will switch to the backup receiving card link.

Interface Example

 Description

 Parameter  Description

 Dual RV Cards Backup  

  

Turn on or turn off the function.

  

: On

 : Off
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 Screen Correction

 Correct Seams

 Adjust the seams between cabinets or modules to improve the display effect.

 Prerequisites

 You have configured the cabinets.

 

 

Notes

 

  

None

Description

 

 

Step 1 Select Correction at the top of the page.

 

 

   

Figure 7-22 Screen correction

Step 2 On the Seams tab in the properties area, toggle the Brightness Calibration switch to  .
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 Only the specific receiving cards support the Seam Correction switch, including the A8s Pro, 

 

 

NV7508, NV7512, NV7516, DH7508-S, DH7512-S, DH7516-S and MRV208-NB7s. The 

adjustment of bright and dark lines can be controlled independently of the coefficients. 

When turned off, the bright and dark lines cannot be adjusted, and any previously made 

adjustments will not be displayed.

 Apart from the above-mentioned receiving cards, the Seam Correction switch will not be 

 

displayed on this interface. In this case, simply toggling on the Brightness Calibration or 

Brightness and Chroma Calibration will ensure that the seam correction takes effect.
 

   Step 3 Toggle on Brightness Calibration or Brightness and Chroma Calibration to view the 

 

  

correction effect.

  Brightness Calibration: Set the Brightness Calibration switch to to make the screen 

 

  

apply the calibration effect made by the calibration platform.

  

   

 

 Brightness and Chroma Calibration: Set the Brightness and Chroma Calibration switch to 

 

 

 

to make the screen apply the calibration effect made by the calibration platform.

The Brightness Calibration and Brightness and Chroma Calibration are mutually exclusive.

Figure 7-23 Correction (seams)

 

 

Step 4 Select a correction mode.

 

 

  

 

Figure 7-24 Select mode (seams)

 

 Cabinet Seams: Correct the seams of cabinets.

 LDM Seams: Correct the seams of modules.

 

  

You can use the corresponding shortcut keys to quickly select the target one. For example, press 

F1 to select all outer border lines of the cabinet.
 

Need LED display solutions? Contact Chipshow: 
manager@chipshow.com | www.chipshow.com



 
 VX Pro Series All-in-One Controller User Manual

 

 

   149
 

 Step 5 When correcting the module seams, if you need to override the numbers of module columns 

  and rows, click the 

  

 

icon next to Select Mode and then perform the settings on the Cabinet 

 

 

 

Structure Override window. Otherwise, skip this step.

Figure 7-25 Cabinet structure override

 

 

Step 6 Set the screen display parameters and check the seam correction effect.

 

 

  

  

Figure 7-26 Adjustment (4-color)

 Brightness: Adjust the display brightness.

 Display image: Set the image displayed on the screen. By default, the current input source is 

being displayed (  ). You can switch to a monochrome display.

 

  

You can use the corresponding shortcut keys to switch between various images. For example, 

press W to switch to white image display.
 

  

  

Step 7 In the topology area, click or click and drag the mouse to select the seams to be corrected.

Step 8 Set the adjustment parameters.
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Figure 7-27 Set the parameters

 Quick adjust: Has a large range of adjustment.

 Fine Adjust: Has a fine range of adjustment.

 Hide the cursor while adjusting: When this is enabled ( ), the cursor will not be displayed 

 

 

on the screen while adjusting brightness and chroma.

  

  

  

 

Step 9 Place the mouse on the scroll wheel icon and adjust the brightness by dragging the wheel icon 

 

up or down, scrolling the mouse wheel, or using the keyboard shortcuts 1+↑/↓.

 Restore: Restore the configuration to the last saved.

 Reset: Reset the configuration to factory defaults.

Step 10 After the settings, click Save.

 

 

Erase Seam Correction

 

If there are any changes made to the cabinets, such as moving a receiving card from one 

cabinet to another or replacing the cabinet module, it may cause bright or dark lines that had 

been previously corrected to appear in the middle of the cabinet or module. In such cases, you 

have the option to remove the seam correction that was applied.

 Prerequisites

 You have configured the cabinets.

 Notes

 None
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Description

Step 1 Select Correction at the top of the page.

Step 2 Select the Cabinet mode.

 

 

  

Figure 7-28 Select mode (cabinet)

 

 

Step 3 Select the target cabinets and then click Erase to remove the seam correction that was applied 

 

 

to them. The erasion will be automatically saved to the hardware once you are done.

Figure 7-29 Erase seam correction

 Screen Settings

 Adjust Image Quality

 Adjust Brightness and Gamma

 

Adjust the Gamma value and brightness of the output to enhance the overall image quality of 

the LED screen.

 Prerequisites

 None
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Notes

 

 

None

Interface Example

 

   

Description

 

Select Screen Settings at the top of the page, and then on the Image Quality tab interface, 

configure the following parameters.

 Parameter  Description

 Brightness  The brightness of the LED screen

 

 

 

Adjust the ratio of the screen brightness to the input level. The parameters are 

read from the receiving card, which default to optimal values at the factory. It is 

recommended the parameter adjustment be carried out by the trained personnel 

Gamma

when necessary.

 Set LED Image Booster

 

Set the LED Image Booster function to improve the delicacy and accuracy of the image color 

and gradation and realize free switching of the display color gamut.

 Prerequisites

 

Before the operation, color gamut and brightness correction by using the CA410-VP427, 

CA410-P427 or CA410-P427H colorimeter must be done.

 Notes

 None

Need LED display solutions? Contact Chipshow: 
manager@chipshow.com | www.chipshow.com



 
 VX Pro Series All-in-One Controller User Manual

 

 

   153
 

 

 

Interface Example

 Description

 Parameter  Description

  Gamut

 

The color gamut standard

The output gamut options include standard 

gamuts, custom gamuts, the original screen 

gamut and the input gamut (From input).

To set the custom gamut, click , select a 

 

gamut in the properties area on the color gamut 

diagram, and adjust the red, green, blue and 

white parameters based on the selected gamut.

 Color Temperature  Drag the slider to adjust color temperature.

 Magic Gray  

  

Turn on or turn off the function.

  

: On

 : Off

 Adjust EOTF

 

 

Prerequisites

 

None

Notes

 The supported adjustment parameters depend on the HDR source settings.
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Interface Example

 

 

Description

 On the Image Quality tab interface, drag the sliders to adjust the related parameters.

 Parameter  Description

 

 

 

Adjust this parameter to enhance the image display effect. The greater the 

value, the clearer the details in the shadow area.

Shadow Compensation

Range: 0 to 100 (default: 33), Step: 1

  

Ambient Light 

Compensation

 

Adjust this parameter to reduce the loss of image details caused by ambient 

light diffusion.

Range: 0 (default) to 80 , Step: 1

 

 

 

Adjust the parameter to reduce the screen overexposure and enhance 

details of the highlight areas.

Clip Level

Range: 0 (default) to 100 , Step: 1

 

Override Peak Screen 

Brightness

 

  

Turn on or turn off the function.

  

On: 

 Off: 

  

 

Peak Screen Brightness

 

Adjust the brightness of the screen when it is functioning normally.

When Override Peak Screen Brightness is enabled, this parameter can be 

adjusted. Range: 100 to 10000 nits (default: 1000 nits), Step: 1
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 Adjust Output

 Set Output Bit Depth

 

 

Prerequisites

 

 

None

Notes

 

 

When you use the HDR function, setting output bit depth to 10bit is required to achieve optimal 

display effect.

Interface Example

 

 

Description

 On the Output tab interface, configure the following parameters.

 Parameter  Description

  

 

Bit Depth

 

Set the output bit depth.

The supported options include 8bit and 10bit.

 Configure 3D

 

Directly connect a third-party 3D emitter using the device's built-in 3D connector, or connect to 

the EMT200 Pro emitter via the device's Ethernet port. Then, use the compatible 3D glasses to 

achieve a 3D display effect.

 

 

Prerequisites

  Video source format: Side-by side, top-and-bottom or frame sequential
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  When paired with the EMT200 Pro, it is recommended to use a 3D source of 60Hz to enjoy 

 an optimal experience.

 

  

Notes

 

 

 When the 3D function is enabled and the video source format is Side-by-Side or Top-and-

 

  

  

Bottom, the device output capacity will be halved.

 When the 3D function is enabled and the video source format is Frame Sequential, you need 

  

 

to manually set the output frame rate which must be the same as the input frame rate.

 The 3D function and input cropping cannot be enabled at the same time.

 After enabling the 3D function on the Screen Settings page, 3D switches of all the layers will 

be toggled on. If you want to use a 2D layer, please toggle off the 3D switch of the desired 

layer in the property area of the Programming page.

 The 3D effect follows the layer. The output area where a 3D layer is located always displays 

 the 3D effect.

 

 

Interface Example

 

 

Description

 On the Output tab interface, configure the following parameters.

 Parameter  Description

 3D  

  

Turn on or turn off the 3D function.

  

: On

 : Off

  

  

Source Format

 

The format of the 3D video source

Set the format to Side-by-Side, Top-and-Bottom or Frame Sequential according to 

the format of the accessed video source.

  Eye Priority Set which image is sent first, the right eye image or the left eye image.

Put on the 3D glasses to view the screen. If the display appears abnormal, adjust the 
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 Parameter  Description

 

parameter value to the other one. If the display is normal, no further adjustments are 

needed.

  3rd Emitter  

  

Turn on or turn off the function.

  

: On

 : Off

 

 

 

Set the delay time of sending the synchronization signal from the 3D signal emitter to 

the 3D glasses. This setting ensures that the switching between left and right eye 

images of the 3D glasses is in sync with the switching between the left and right eye 

images on the screen. This parameter is applicable to both the NovaStar and third-

Signal Delay

party emitters.

 Check Load

 Check the capacity usage of each Ethernet port of the device.

 

 

Prerequisites

 

 

None

Notes

 

 

None

Interface Example

 

  

Description

 

On the Output tab interface, click next to the device information to check the usage of the 

device loading capacity.
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 Layer Operations

 Add Layers

 Add layers to screen

 

 

Prerequisites

 Make sure the device is in Video Controller mode before adding layers.

 Notes

 The maximum number of layers that can be added depends on the connected device.

 Device Model  Number of Supported Layers (2K×1K)

 VX400 Pro  6

 VX600 Pro

 VX1000 Pro

 VX2000 Pro  12

 

  

Description

 

Step 1 Click Programming at the top of the page to enter the layer editing page. Select the desired 

 screen from the left screen list, and then click the Input tab.
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Figure 7-30 Programming (VX2000 Pro)

 

 

 

Step 2 Add the layers to the screen.

 

 

Drag an input source in the input list to the screen.

Step 3 Perform the desired layer operations as required.

 

 

Figure 7-31 Layer operations

 Configure Video Source Properties

 

In the input list, select an input source and set the relevant properties on the right pane. For 

detailed configurations and parameter descriptions, please refer to Configure Input Properties.
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 Mosaic Source Settings

 Both HDMI and OPT sources support mosaicing.

 View Mosaic Source Info

 View the basic properties of the mosaic source and change the source name.

 Prerequisites

 A mosaic source has been configured and its signal is fine.

 

 

Notes

 

 

None

Interface Example

 

 

Description

 

On the Mosaic Source tab interface, type in a new source name and click anywhere else on the 

interface to save the change.
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Configure Mosaic Sources

 Set the mosaic source name, sub-source type, mosaic layout as well as sub-source size.

 

 

Prerequisites

 

 

None

Notes

 

 

Only the input sources of the same connector type support mosaicing, and the frame rates of 

sub-source must be the same.

Interface Example

 

 

Description

 On the Edit Mosaic tab interface, configure the following parameters.

 Parameter Name  Description

 Name  The name of the mosaic source

  

  

Source Type

 

The type of the sub-sources

Config method: Select HDMI 1.3, HDMI 2.0 or OPT from the drop-down list.

  Layout

 

The layout of the mosaic source

Config method: Select the desired layout from the standard layout template, and 

then drag the inputs in the input list to the sub-cells respectively.

 Sub-Source Size  

  

The size of the sub-sources

  

Default width: 1920 pixels, max width: 8192 pixels

 Default height: 1080 pixels, max height: 8192 pixels
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 Parameter Name  Description

   Max width and height: 4096×2160

 

  

Configure USB Source Properties

 

Select a USB source in the input list and configure relevant properties on the USB Playback 

Settings tab interface.

The models of devices that support USB playback and the corresponding output resolutions for 

USB sources are listed below.

 Device Model  USB Source Resolution

 VX400 Pro  1920×1080@60Hz

 VX600 Pro

 VX1000 Pro

 VX2000 Pro  3840×2160@60Hz

 Play USB Files

 Prerequisites

 

The U-DISK connector on the front panel is inserted with a USB drive which is successfully 

identified.

 

 

Notes

 

 

None

Interface Example
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 Description

 

In the playlist, select a file to play it and you can also stop the playback, play the previous or 

next file as well as set the playback mode.

 Configure Playback Parameters

 Prerequisites

 

The U-DISK connector on the front panel is inserted with a USB drive which is successfully 

identified.

 

  

  

 

Notes

 

 

  

  

  

  

 

 Single-partition USB drive supported

 File system: NTFS, FAT32 and exFAT

 Max. width and height of media files

 

 

 

 

Width: 3840 pixels, height: 2160 pixels

 Picture format: jpg, jpeg, png and bmp

 Decoded image resolution: 3840×2160 or lower

 Video format: mp4, mkv, mov, avi, flv, m4v, mpg, mpeg, ts

 Video coding: H.264, H.265, MPEG-2, MPEG-4

 Max. video frame rate:

 

 

 

  

 

H.264: 3840×2160@30fps, H.265: 3840×2160@60fps

MPEG-2/MPEG-4: 1920×1080@60fps

 Max bitrate:

 

 

H.264/H.265: 100Mbps

MPEG-2/MPEG-4: 50Mbps

 Audio coding: AAC, AC3, DTS, MP3, DVD, DVD_LPCM, MP2, OPUS

 Audio sampling rate:

 

opus: 24kHz, 48kHz

Other formats: 22.05kHz to 94kHz
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Interface Example

 

 

Description

 On the USB Playback Settings tab interface, configure the following parameters.

 Parameter  Description

 Playback Mode  The playback mode of the file

 

 



 

 



   

Repeat: Play the files in the playlist in order. Once the playback of 

the last file is completed, replay the first file.

Repeat in Order: Play the files in the playlist in order. Once the 

playback of the last file is completed, the screen will display a black 

image and the playback will stop.

Repeat One: Loop playback of the current file.

 File Type  

  

  

The type of the playback file

  

Video

Image





 All: Videos and images

 

After the file type is selected, only the file of the selected type will be 

 displayed in the playlist.

   Playback Duration

 

The duration of the image playback

The value ranges from 1 to 60 and it defaults to 5. (Unit: s)

  Trans Effect The trans effect of the image

Supported trans effect: Ripple, zoom in, cut out, flip, blinds, H wipe, V 

wipe, cube, dissolve, grid, swapping, scroll, fade in/out, twirl, heart 

trans, doorway, perspective triangle, disappear, bounce, pinwheel and 
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 Parameter  Description

 random.

  Trans Duration

 

The trans duration of the image

The value ranges from 0.5 to 2 and it defaults to 0.5. (Unit: s)

  Auto Playback

 

The auto playback switch

Set whether to automatically play the USB files after the device is 

powered off and then power on with a USB drive inserted.

  

 

 

: On

If Resume Playback not enabled, replay the files in the playlist in 

order; If enabled, replay the file being played before power failure 



from the beginning.

   : Off

 Resume Playback  Turn on or turn off the function.

  

 

: On

If a file is playing before the device power failure, enabling this 

function allows to replay the file from beginning after the device is 

powered on with a USB driv



e inserted.

  

 

Off:

Replay the files in the playlist in order.

 

   

 



  

 

Enabling Resume Playback will also activate the Auto Playback

feature at the same time.

After Resume Playback is enabled, if the file being played before 

power failure cannot be found, the files will be played from the 



beginning of the playlist in order.

 Set Audio

 Prerequisites

 None

 Notes

 None
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Interface Example (VX2000 Pro)

 

  

Description

 

On the Programming interface, hover the mouse over and set the following parameters in 

the popup menu.

 Parameter  Description

 Output  Set the output audio.

 

 



  

 



 

 

 

Layer n: Output the audio of the current layer input source. When 

you switch the current layer input source, the audio will also be 

changed.

Audio In: Output the analog audio coming from an external audio

device. When you switch the current layer input source, the audio will 

not be changed.

Embedded audio of an input source: Output the fixed embedded 

audio. When you switch the current layer input source, the audio will 

not be changed.

The supported input source types include HDMI sources, DP sources, 



and USB sources.

 

 The input source audio of the layer 1 is output by default.

  Volume

 

The output volume

The value ranges from 0 to 100 and it defaults to 50%.
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 Parameter  Description

  

  

0%: Mute

100%



 : Output at maximum volume.

 

  Click  below Volume to enable or disable the audio.

 Set Input Source Audio

 

 

Prerequisites

 

 

None

Notes

 

 

None

Interface Example (VX2000 Pro)
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Description

On the Programming interface, click the Input tab to display the input source list. Hover the 

  

mouse over the desired input source and click 

audio to Embedded Audio or Audio In

. In the popup menu, set the input source 

.

 Configure Layer Properties

 

Select the desired layer, and then set the layer-related properties in the property area on the 

right pane.

 Configure Basic Properties

 Configure the layer name, aspect ratio, position, size, as well as enabling the 3D effect.

 

 

Prerequisites

 

 

 

None

Notes

 

After enabling the 3D function on the Screen Settings page, 3D switches of all the layers will be 

toggled on. If you want to use a 2D layer, please toggle off the 3D switch of the desired layer in 

the property area of the Programming page.
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Interface Example

 

  

Description

 On the Basic tab interface, configure the following parameters.

 Parameter  Description

 Name  The layer name

 

 Aspect 

Ratio

 

The ratio of the layer's width to its height

After the aspect ratio is changed, the height of the layer remains unchanged, and the 

device automatically calculates its width.

  X

 

The horizontal starting position of the layer on the screen

The coordinates of the first pixel in the upper left corner of the screen are (0,0).

  Y

 

The vertical starting position of the layer on the screen

The coordinates of the first pixel in the upper left corner of the screen are (0,0).

  W

 

The horizontal size of the layer

The minimum width of a layer: 64 pixels

  H

 

The vertical size of the layer

The minimum height of a layer: 64 pixels

 3D  

  

Turn on or turn off the function

  

: On

 : Off
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 Crop Layer Sources

 

When there are black borders or other redundant info in the input source image, the required 

picture can be retained through the cropping the input source, so as to improve the screen 

utilization.

 Prerequisites

 A fine signal is connected to the input connector.

 

  

  

Notes

 

 

 The status and capacity of the cropped source remain consistent with the original one.

 The input cropping and 3D functions cannot be enabled at the same time.

Interface Example

 

 

Description

 On the Advanced tab interface, configure the following parameters.

 Parameter  Description

 

Layer Source 

Crop

 

  

Turn on or turn off the function.

  

: On

 : Off

 X  The horizontal start position of the cropped area relative to the original source

 Y  The vertical start position of the cropped area relative to the original source
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 Parameter  Description

 Width  The number of horizontal pixels (width) of the cropped area

 Height  The number of vertical pixels (height) of the cropped area

 Configure OSD

 Both the text OSD and image OSD are supported.

 Prerequisites

 

Before setting a time OSD or weather OSD, please ensure that the device is connected to the 

network to obtain the precise time and weather information.

 

  

 

Notes

 

  

 The OSD locates at the top and its priority cannot be adjusted.

 The text OSD and image OSD cannot be enabled together.

 

 The OSD function and remote control function cannot be enabled together.

OSD Type Descriptions

 OSD Type  Description

   

 

  

  

  

  

Up to four text OSD presets are supported, and the preset 1 is selected by Text OSD 

default. The quantity of the text components are as follows.

  

− Static text OSD: 10

− Weather OSD: 2

− Time OSD: 2

− Dynamic text OSD: 1

 Does not support settings of the size and position of a text OSD.

 

 The dynamic text OSD and other text components cannot be used together.

   

  

  

Image gallery capacity: 75 MB

Supported image OSD formats: PNG/JPG/JPEG/BMP





Image OSD

 Width and height limitations of a single image:
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 OSD Type  Description

  − VX400 Pro/VX600 Pro/VX1000 Pro: Max width × Max height ≤ 

 

 

4096×1080, max width: 10240 pixels, max height: 8192 pixels

 

 

  

  

− VX2000 Pro: Max width × Max height ≤ 4096×2160, max width: 16384 

  

pixels, max height: 8192

Note: If the max width and height limitations are exceeded, you need to 

scale or crop the image in Unico, and the width and height of the cropped 

should be greater than 64 pixels.

Supports setting of the image OSD position.

Does not support setting of the image OSD size.





 Does not support setting of the image OSD opacity.

 

  

  

Configure Text OSD

 

  

Step 1 In the screen list on the left, select the desired screen.

Step 2 Click the OSD tab.

 Step 3 Toggle the OSD switch to  

 

to enable the OSD function.

 

 

   

Figure 7-32 Enable OSD

 

Step 4 Click the Text OSD tab, and drag the desired OSD preset to the editing area. The OSD preset 1 

 

is selected by default.

OSD preset-related operations:
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 Change the OSD preset name: Hover the mouse over the desired OSD preset, and then click 

that appears. Enter a new preset name, and then click elsewhere in the interface to 

 

 

complete the preset name change.

  Clear the OSD preset: Click 

 

at the top right corner of the desired preset, and then click 

 

 

Yes in the popup dialog box to clear OSD components saved in the selected preset.

   Lock/Unlock the OSD preset: Click 

 

 

at the top right corner of the desired preset to lock 

 

or unlock the preset.

 Save the OSD preset: Click at the top right corner of the desired preset, and then select 

 

  

another preset to save the OSD components from the original preset to the selected one.

Step 5 On the right Layer pane, drag the ,  ,  or 

 

 

icon to add a static text 

 

  

  

  

  

  

 

OSD, dynamic text OSD, weather OSD or time OSD.

Step 6 Set the position and size of the OSD layer.

 

  

 X: Set the horizontal distance from the top left corner of the OSD layer to that of the screen.

 Y: Set the vertical distance from the top left corner of the OSD layer to that of the screen.

 W: Set the OSD layer width.

 H: Set the OSD layer height.

Step 7 Click the created OSD layer to display the OSD configuration area on the right.

Step 8 Set the related parameters of the added OSD component. For the parameters of each OSD 

component, please refer to the following descriptions.

Step 9 Click Apply at the top right corner to complete the settings and display the set OSD on the 

 screen.

 

 Select the desired OSD components, and then click 

 

shown at the top right corner. In the 

 popup dialog box, click Yes to delete the selected OSD component.
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Static Text OSD

 

 

 

Figure 7-33 Interface example

 Table 7-3 Parameter descriptions

 Area  Parameter  Description

 Text area   

 

-

 

Enter the text OSD content.

The static text OSD supports multi-line display. You can press 

Enter on the keyboard to have line breaks.

 Character  Font Settings  Select the desired text font from the drop-down list.

  

 

 

Library 

 

  



   

 

Delete single/multiple fonts: Click Library. In the popup window, 

check the boxes next to the desired fonts, and then click Delete

to delete the selected fonts.

Delete all fonts: Click Library. In the popup window, check the 

box next to Library, and then click Delete to delete all fonts.

Add fonts: Click Library. In the popup window, click New to add 

the fonts saved in the local computer to the font library.

 Font size

 

: Set the font size. The value ranges from 8 to 512 px and it 

defaults to 100 px.
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 Area  Parameter  Description

   

  

Font style

  

: Make the text bold or not.

: Italicize the text or not.





 : Underline the text or not.

 Character spacing

 

: Set the spacing between characters. The value ranges from 0 

to 1000 px and it defaults to 0 px.

 Row spacing : Set the spacing between rows. This parameter is available 

 

when there are multiple rows. The value ranges from 0 to 1000 px 

and it defaults to 0 px.

 Alignment method  Set the text alignment method.

  : Align the text content with the left margin of the display 

 

  

area.

 

: Center the text content in the display area.

: Al



 ign the text content with the right margin of the display 

 

  

  

area.

  

: Align the text to the top of the display area.

: Center the text vertically to the display area.





 : Align the text to the bottom of the display area.

  

 

Layout

 

Select the text layout direction from the drop-down list.

The supported options include Horizontal, From Right (Vertical)

and From Left (Vertical).

 

Text position and 

size

 Set the position and size of the OSD component.

  

 



 

 

  



  

X: Set the horizontal distance from the top left corner of the OSD 

component to that of the screen.

Y: Set the vertical distance from the top left corner of the OSD 

component to that of the screen.

W: Set the OSD component width.

 H: Set the OSD component height.

 

Common 

properties

   

 

Click the color block icon next to Select Color to open a window 

where you can select the desired color or customize your own 

color. Drag the slider or enter a value in the text box to adjust the 

opacity. The opacity ranges from 0% (totally transparent) to 100% 

(nontransparent

Text color

).

  

 

Toggle on/off Background Color to enable or disable the Background color

background color settings.
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 Area  Parameter  Description

 

 

Click the color block icon next to Select Color to open a window 

where you can select the desired color or customize your own 

color. Drag the slider or enter a value in the text box to adjust the 

opacity. The opacity ranges from 0% (totally transparent) to 100% 

(nontransparent).

 

 

Dynamic Text OSD

 

 

 

Figure 7-34 Interface example

 Table 7-4 Parameter description

 Area  Parameter  Description

 Text area  -  Enter the text OSD content.

 Character  Font Settings  Select the desired text font from the drop-down list.

  

 

 

Library 

 

Delete single/multiple fonts: Click Library. In the popup window, 

check the boxes next to the desired fonts, and then click Delete

to delete the selected fonts.

Delete all fonts: Click Library . In the popup window, check the 
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 Area  Parameter  Description

  

  

 

box next to Library, and then click Delete to delete all fonts.

Add fonts: Click Library. In the popup window, click New to add 

the fonts saved in the local computer to the font library.

 Font size

 

: Set the font size. The value ranges from 8 to 512 px and it 

defaults to 100 px.

   

  

Font style

  

: Make the text bold or not.

: Italicize the text or not.





 : Underline the text or not.

 Character spacing

 

: Set the spacing between characters. The value ranges from 0 

to 1000 px and it defaults to 0 px.

 

 

Set the text scrolling speed. The value ranges from 0 (static) to 10 Speed

(fastest).

 Direction  

  

Set the text scrolling direction.

  

From Left: The text scrolls from right to left in the display area.

 From Right: The text scrolls from left to right in the display area.

 

Text position and 

size

 Set the position and size of the OSD component.

 

 



 

 

   



  

X: Set the horizontal distance from the top left corner of the OSD 

component to that of the screen.

Y: Set the vertical distance from the top left corner of the OSD 

component to that of the screen.

W: Set the OSD component width.

 H: Set the OSD component height.

 

Common 

properties

  

 

Click the color block icon next to Select Color to open a window 

where you can select the desired color or customize your own 

color. Drag the slider or enter a value in the text box to adjust the 

opacity. The opacity ranges from 0% (totally transparent) to 100% 

Text color

(nontransparent).

  

 

 

 

Toggle on/off Background Color to enable or disable the 

background color settings.

Click the color block icon next to Select Color to open a window 

where you can select the desired color or customize your own 

color. Drag the slider or enter a value in the text box to adjust the 

opacity. The opacity ranges from 0% (totally transparent) to 100% 

Background color

(nontransparent).
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Weather OSD

 

 

 

Figure 7-35 Interface example
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  Table 7-5 Parameter description

 Area  Parameter  Description

 

Weather 

settings

 Location  Click 

 

to open the map window, where you can select the 

 

desired location or enter the address. Click OK to complete the 

settings.

 

 

Set the automatic refresh interval for the weather information. The Refresh

value ranges from 1 to 1440 minutes and it defaults to 10 minutes.

 

 

Set the text language. The supported options include English and Language

Chinese.

  Temperature Unit  Set the temperature unit. The supported options include ℃ and ℉.

  

 

Content

 

Set the content to be displayed in the weather OSD.

Check the box next to the desired content to display it in the 

weather OSD. You can also click Custom Tab to edit the default 

display content.

 Layout  Display mode  

  

Set the display mode of the weather OSD.

  

Single Line: Display all items in single line.

Multi-Line: Display each item in single-



 line.

  

 

 

Set the spacing between each selected content in Single Line

display mode or set the spacing between rows in Multi-Line

Spacing

display mode.

 Text  Font Settings  Select the desired text font from the drop-down list.

  

 

 

Library 

 

  



  

 

Delete single/multiple fonts: Click Library. In the popup window, 

check the boxes next to the desired fonts, and then click Delete

to delete the selected fonts.

Delete all fonts: Click Library. In the popup window, check the 

box next to Library, and then click Delete to delete all fonts.

Add fonts: Click Library. In the popup window, click New to add 

the fonts saved in the local computer to the font library.

 Font size

 

: Set the font size. The value ranges from 8 to 512 px and it 

defaults to 100 px.

   

  

Font style

   

: Make the text bold or not.

: Italicize the text or not.

: Underline the text





 or not.

 Character spacing

 

: Set the spacing between characters. The value ranges from 0 

to 1000 px and it defaults to 0 px.
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 Area  Parameter  Description

 Row spacing

 

: Set the spacing between rows. This parameter is available 

 

when there are multiple rows. The value ranges from 0 to 1000 px 

and it defaults to 0 px.

 Alignment method   : Align the text content with the left margin of the display 

 

 

area.

 : Center the text content in the display area.

  





 

Text position and 

size

 Set the position and size of the OSD component.

 

 



 

 

  



  

X: Set the horizontal distance from the top left corner of the OSD 

component to that of the screen.

Y: Set the vertical distance from the top left corner of the OSD 

component to that of the screen.

W: Set the OSD component width.

H: Set the OSD component h



 eight.

 

Common 

properties

  

 

Click the color block icon next to Select Color to open a window 

where you can select the desired color or customize your own 

color. Drag the slider or enter a value in the text box to adjust the 

opacity. The opacity ranges from 0% (totally transparent) to 100% 

Text color

(nontransparent).

  

 

 

 

Toggle on/off Background Color to enable or disable the 

background color settings.

Click the color block icon next to Select Color to open a window 

where you can select the desired color or customize your own 

color. Drag the slider or enter a value in the text box to adjust the 

opacity. The opacity ranges from 0% (totally transparent) to 100% 

Background color

(nontransparent).
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Time OSD

 

 

Figure 7-36 Interface example
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  Table 7-6 Parameter descriptions

 Area  Parameter  Configuration

 Configuration  Time zone  Select the time zone from the drop-down list.

 

 

Set the time offset value. The value ranges from -2 to +2 (unit: Time offset

hour).

 Content  

 

Set the text language. The supported options include English Language

and Chinese.

 Date  

  

Display or hide the date.

  

: Display the date.

 : Hide the date.

 

  

Set the year format. The supported options include YYYY (four-

digit year) and YY (two-

Year format

digit year).

 Date format  Set the date format.

  Time type  The supported options include Local Time and Network Time.

 Week  

  

Display or hide the week.

  

: Display the week.

 : Hide the week.

 Time  Display or hide the time.
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 Area  Parameter  Configuration

  

  

: Display the time.

: 



 Hide the time.

 24-hour  

  

Display the time with 24-hour format or not.

  

: Display the time with 24-hour forma

: Display the time with 12-



 hour forma

 Time Format  Set the time format.

 Layout  Display mode  Set the display mode of the time OSD.

 

 



  

Single-Line: Display the date, day of the week and time in 

single-line.

Multi-Line: Display each item in single- line.

 

 

  

Spacing: Set the spacing between the date, day of the week and 

time in Single Line display mode or set the spacing between 

rows in Multi-Line

Spacing

display mode.

 Text  Font Settings  Select the desired text font from the drop-down list.

  

  

Library 

 

  



  

 

Delete single/multiple fonts: Click Library. In the popup 

window, check the boxes next to the desired fonts, and then 

click Delete to delete the selected fonts.

Delete all fonts: Click Library. In the popup window, check the 

box next to Library, and then click Delete to delete all fonts.

Add fonts: Click Library. In the popup window, click New to 

add the fonts saved in the local computer to the font library.

 Font size

 

: Set the font size. The value ranges from 8 to 512 px and it 

defaults to 100 px.

   

  

Font style

   

: Make the text bold or not.

: Italicize the text or not.

: Underline the text





 or not.

 Character spacing

 

: Set the spacing between characters. The value ranges from 

0 to 1000 px and it defaults to 0 px.

 

 

Row spacing

 

: Set the spacing between rows. This parameter is available 

when there are multiple rows. The value ranges from 0 to 1000 

px and it defaults to 0 px.

 Alignment method   : Align the text content with the left margin of the display 

 area.

   : Center the text content in the display area.
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 Area  Parameter  Configuration

  

 

Text position and 

size

 Set the position and size of the OSD component.

 

 



 

 

  



  

X: Set the horizontal distance from the top left corner of the 

OSD component to that of the screen.

Y: Set the vertical distance from the top left corner of the OSD 

component to that of the screen.

W: Set the OSD component width.

H: Set the OSD component h



 eight.

 

Common 

properties

  

 

Click the color block icon next to Select Color to open a window 

where you can select the desired color or customize your own 

color. Drag the slider or enter a value in the text box to adjust 

the opacity. The opacity ranges from 0% (totally transparent) to 

Text color

100% (nontransparent).

  

 

 

 

Toggle on/off Background Color to enable or disable the 

background color settings.

Click the color block icon next to Select Color to open a window 

where you can select the desired color or customize your own 

color. Drag the slider or enter a value in the text box to adjust 

the opacity. The opacity ranges from 0% (totally transparent) to 

Background color

100% (nontransparent).

 Configure Image OSD

 

  

  

Add Image OSDs

 

  

Step 1 In the screen list on the left, select the desired screen.

Step 2 Click the OSD tab.

 Step 3 Toggle the OSD switch to  to enable the OSD function.
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Figure 7-37 Enable OSD

 

 

Step 4 Click the Image OSD tab to enter the image OSD configuration page.

 Step 5 Click  

   

 

to open a window where you can select the desired OSD images.

 

 

Step 6 Click Open to upload the selected images.

Step 7 Click and drag the uploaded image to the editing area to add an image OSD.

 

 

 

Figure 7-38 Add image OSDs

 

 

Step 8 Set the position and size of the OSD layer.

  X: Set the horizontal distance from the top left corner of the OSD layer to that of the screen.
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 Y: Set the vertical distance from the top left corner of the OSD layer to that of the screen.

Delete Gallery Images

 Delete a single image: Hover the mouse over the desired image, and then click 

 

. In the 

 

 

popup dialog box, select Yes to delete the selected image.

  

 Delete multiple images: Click Edit, and then check the boxes next to the desired image or 

 

 

check the box next to All. After selection, click and select Yes in the popup dialog box.

Export Gallery Images

Click Edit, and then click . In the popup window, select the saving path to export all images 

 in the gallery to your local computer.

 

  

Manage Presets

 

 

  

   

To manage the presets, click Preset on the right side of the Programming interface and 

perform the corresponding actions as needed.

Save Presets

Step 1 In the screen list on the left, select the desired screen.

Step 2 On the Preset tab interface, click Add at the bottom, and the system will automatically display 

 the preset number binding window.
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Figure 7-39 Bind presets (VX2000 Pro)

 

 

Step 3 In the preset number binding window, select the desired key number to save the current layer 

 

information to the preset.

One key number corresponds to one preset. The name of the save preset: Preset X ("X" refers to 

the bound key number.)

Switch Display Style of Preset List

  

 

 : List view

  

 

 : Graphical view

 Load Presets

 In the preset list, select the desired preset to load it.
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After the preset is successfully loaded, the 

preview area.

icon will be displayed at the top left of the 

Rename Presets

 In the list view mode ( ), hover the mouse over the preset, and then click . Enter a new 

 

 

name and then click elsewhere to make the change take effect.

 In the graphical view mode (  

 

), hover the mouse over the preview area, and then click 

 

that appears. In the popup menu, select Rename and enter a new name, and then click 

elsewhere to make the change take effect.

 

 

View Preset Details

 In the list view mode (  ), hover the mouse over the preset, and then click that appears. 

 

 

In the popup window, you can view the name and screen of the preset.

 In the graphical view mode (  

 

 

), hover the mouse over the preview area, and then click 

 

that appears. In the popup menu, select Details to show the popup window where you can 

view the name and screen of the preset.

Set Preset Switching Effect

Click 

 

  

 

, and then select the desired transition effect in the popup menu. The supported 

 

  

 

options are as follows.

 Cut: Switch one preset to another with no transition effect.

 Fade: Switch one preset to another with a fade effect.

 

After selecting Fade effect, click OK in the popup dialog box. Additionally, you can set the 

transition duration. The value ranges from 1s to 3s and it defaults to 2s.

 

  

  

The fade effect takes effect on presets with less than 7x SL layers only.

 Only the VX2000 Pro supports setting of the preset switching effect.
 

 

 

Delete Single Presets

 In the list view mode (  ), hover the mouse over the preset, and then click 

 

that appears. 

 In the popup window, select Yes to delete the preset.
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  In the graphical view mode (  

   

), hover the mouse over the preview area, and then click 

 

that appears. In the popup menu, select Delete, and then select Yes in the popup dialog box.

Delete Multiple Presets

 

Click Operation, check the boxes next to the desired presets or check Select All, and click 

In the pop-up dialog box, select Yes

. 

.

 Tools

 Maintenance

 

  

 

 

Maintain Devices

 

 

In the menu bar, navigate to Tools > Maintain. Select the Device tab and the target devices, 

and then do the following as required.

Figure 7-40 Device maintenance (VX2000 Pro)

 Update

 

  During the update process, power-off and all operations are NOT allow ed.
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Before updating the device, please connect the control PC and device using an Ethernet cable. 

USB connection is not allowed for update.
 

  

  

   

   

  

 

  

Step 1 Click Update.

Step 2 In the pop-up dialog box, select the update file (.img) and click OK.

Step 3 Confirm the devices to be updated, and click the Update button.

Step 4 In the pop-up dialog box, click Yes and wait until the update completes.

Step 5 After the update completes, click OK.

Restart

 

Click Restart. In the displayed dialog box, click Yes to restart the device.

Factory Reset

 

  

  

  

  

Please do this with great caution.

The reset action does not affect the device firmware version.

Power-off is NOT allowed during the reset process.







 The device will restart automatically after the reset is completed.
 

 

 

  

 

 

Click Factory Reset. In the pop-up dialog box, select Keep user data, Retain IP only or Reset 

all, and then click OK.

 Retain user data

 

 

 

Retain the input EDID, imported files, language, device name, device IP, belonged project 

and restore points.

 Retain IP only

 

Only retain the device IP address and reset other parameters to factory defaults.

 Reset all

 Reset all parameters.
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Figure 7-41 Factory reset

 

 

 

Export Logs

 

 

 

 

Click Export Log. In the dialog box that appears, select a path and click Save to save the device 

logs to local computer.

Device Diagnostics

 

 

Click Diagnostics. After the diagnostics completes, you can view the test result and take 

necessary measures as required.

Figure 7-42 Device diagnostics (VX2000 Pro)
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Maintain Cabinets

 

 

In the menu bar, navigate to Tools > Maintain. Select the Cabinet tab and the target cabinets, 

and then do the following as required.

Figure 7-43 Maintain cabinets

 

 

View Cabinet Information

 

  

View the cabinet online status, cabinet manufacture, cabinet model, receiving card model, 

receiving card firmware, associated device, card (only applicable for card-based device), device 

IP and cabinet position.

View Receiving Card Firmware

 

 

 

Click Details to view the FPGA and MCU versions of the receiving card.

Cabinet Painter

 

Click Painter and select one or more cabinets so that other cabinets can have the same 

firmware program and configuration file as the selected cabinet.

Update Cabinet Configuration Files

 Select one or multiple cabinets, and then click Update.
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Figure 7-44 Update cabinets

 

 

 

 

Select the desired update method in the popup window.

 Select an existing file: Choose an NCP/rcfgx file from the popup window and click Update.

 Import a new file: Click Import to upload an NCP/ file. You can select the import objects 

 

 

(multiple selections are possible) from Local pack or Device pack. Once the upload is 

complete, return to the Update interface, select the imported NCP/rcfgx file, and click 

Update.

 Firmware Program: Update the firmware version of the receiving card. Upload a file in image 

 

 

format, and then click Update.

 Configuration File: Update the cabinet configuration file. Upload an NCP/ rcfgx file, and then 

click Update.

 Image Quality File: Import the adjustment parameters of the image quality. Upload a file in 

 vglcx format, and then click Update.

 

 The supported cabinet update method depends on the receiving card model.
 

 

  

Restart Cabinet

 

 

Click Restart. In the popup dialog box, click OK to restart the cabinet.

Refresh Cabinet Info

 Click Refresh to refresh the cabinet information.

 Configure Device Backup

Device backup allows you to set the backup relationship between two devices. You can set one 

of the devices as the primary device or the backup device. When the primary device has a 
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problem or the primary device's Ethernet cable fails, the backup device will take over the 

responsibilities of the primary device seamlessly and continue to work well to ensure the LED 

screen will not go black.

 

 

Prerequisites

 

 

 Before creating a backup relation, make sure that both the primary and backup devices are 

on the same LAN.

 In a backup relation, the models and device versions of the primary and backup devices must 

 be the same.

 

 

Notes

 You have three options to create a backup relation: NovaLCT, Unico, or the device LCD 

 

 

menu. However, be aware that these methods do not synchronize with each other. Using 

more than one can lead to data problems. To prevent issues, choose only one method for 

setting up your backup. If you do mix them, you'll need to reset the device to factory settings 

and start over with just one method.

 

 

   

   

 In the device backup mode, the quantity of the cabinets loaded by each Ethernet port on 

 

both the primary and backup devices must be the same, but their data flow must be in a 

reversed way.

Operation Procedure

Step 1 In the menu bar, go to Settings > Device Backup.

Step 2 In the pop-up window, click Add to add a backup relation.
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Figure 7-45 Add backup relations (VX2000 Pro)

 

 

   

  

Step 3 Select the primary and backup devices from the drop-down lists respectively.

 

After the action completes, the firmware versions of the primary and backup devices will be 

displayed.

Step 4 Click OK to complete the backup relation settings.

Step 5 (Optional) Click Delete to delete the desired backup relation.

 

 

Manage Cabinet Library

 

In the menu bar, go to Tools > Cabinet Library. Do the followings as needed to manage the 

cabinet library files.
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Upload Cabinet Files

 Step 1 Click Add and select the cabinet type in the displayed window.

 

  

 

The cabinet types are as follows.

 

 

  

 Cabinet File

Figure 7-46 Cabinet files

 

 Virtual Cabinet: If Virtual Cabinet is selected, you need to configure the parameters such as 

 cabinet name, resolution width and height.
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Figure 7-47 Virtual cabinets

 

  

 

   

Step 2 Select the NCP/.rcfgx file to be imported from the local computer and click Upload.

 

 

  

After the file is selected, you can click Delete to delete the uploaded file.

Export Cabinet Files

Step 1 Select one or more files on the Cabinet Library interface and then click Export.

 

 

For batch export, multiple files will be compressed as a .zip file and exported.

Step 2 Select a local directory and click Save.

Sync Cabinet Files

 

 

 Sync cabinet files between devices

 

 

1) Select the files to be synced (multiple files can be selected), and click Sync Cabinet 

Library.

2) On the displayed window, select the devices to which the files are synced (multiple 

 devices can be selected).
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Figure 7-48 Sync cabinet files (VX2000 Pro)

 

3) Click OK.

View Cabinet and Flash Info

 

 

Select a cabinet file, and the information about all the cabinets that use this cabinet file will be 

displayed.

 Device Discovery

 Add devices across different network segments or non-discoverable devices via IP addresses.

 

 

Prerequisites

 

None

Notes

 None
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Interface Example

 

   

Configuration

 

Navigate to Tools > Device Discovery from the menu bar. In the popup window, click Add to 

manually input the device IP. Once added, click OK.

 Test Tool

 Utilize test patterns to assess display performance and pinpoint issues.

 Prerequisites

 

For better software operation when the display window is large, it is recommended to prepare 

an extended display for viewing test patterns.

 Notes

 The test tool only supports Windows operating systems.
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Interface Example

 

  

 

Description

 

Navigate to Tools > Test Tool from the menu bar to open the test tool configuration interface. 

Please refer to the Test Tools User Manual for specific operations.

 Software Settings

 Switch UI Language

 

Select the desired language from the drop-down list at the top right corner to switch the UI 

language.

 Change Skin

 In the upper right corner of the interface, click  to select the desired skin.
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Figure 7-49 Change skin

 

  

Export Logs

 In the menu bar, navigate to Settings > Export Log to export the logs of the Unico software.

 

 

 

   

 

Configure Preferences

In the menu bar, navigate to Settings > Preferences. Turn on the desired features (checked "√") 

or off (unchecked).

 Screen Resources: Show the layer resources on the Programming interface if enabled.

 Lock Aspect Ratio: Lock the aspect ratio when adjusting the width and height of new layers 

 if enabled.

 

  

View Software Info

 In the menu bar, go to Help > About Us to view the software-related info.

 

   

Check User Manual

 

In the menu bar, navigate to Help > User Manual to scan the QR code or click the link provided 

to access the latest product documentation.
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  Appendix

Loading Capacity Calculation Method in Low Latency 

 

 

 

Mode

 

  

  

  

 

In low latency mode, the effective loading capacity of a single Ethernet port will change 

according to the coordinates of the connected cabinets. This chapter introduces how to 

calculate the effective loading capacity of an Ethernet port in low latency mode.

Calculation Formula

 

Max loading capacity of a single Ethernet port = (1 - (Y / H)) × TOTAL

 Y: The minimum Y coordinate of all cabinets loaded by a single Ethernet port

 H: The total height of the current canvas

 TOTAL: The maximum loading capacity of a single Ethernet port in common mode, fixed to 

 

 

  

 

   

650,000.

Calculation Example

 

 

As shown in the figure below, the minimum Y coordinate of the cabinets connected to an 

Ethernet port is 1200 (Y = 1200), the total height of the canvas is 2160 (H = 2160), and the max 

loading capacity is 650,000 (TOTAL = 650,000). Based on the calculation formula, the maximum 

loading capacity of this Ethernet port in low latency mode is:

(1 - (1200 / 2160)) × 650,000 ≈ 0.556 × 650,000≈ 361,400
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The loading capacity of the Ethernet port is only related to the minimum Y coordinate of the 

connected cabinets and has nothing to do with the X coordinate.
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Copyright
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